
Khi đọc qua tài liệu này, nếu phát hiện sai sót hoặc nội dung kém chất lượng 
xin hãy thông báo để chúng tôi sửa chữa hoặc thay thế bằng một tài liệu cùng 
chủ đề của tác giả khác. Tài liệu này bao gồm nhiều tài liệu nhỏ có cùng chủ 
đề bên trong nó. Phần nội dung bạn cần có thể nằm ở giữa hoặc ở cuối tài liệu 
này, hãy sử dụng chức năng Search để tìm chúng. 

Bạn có thể tham khảo nguồn tài liệu được dịch từ tiếng Anh tại đây:

http://mientayvn.com/Tai_lieu_da_dich.html

Thông tin liên hệ: 

Yahoo mail: thanhlam1910_2006@yahoo.com

Gmail: frbwrthes@gmail.com



 

 

Những cách định dạng văn bản trong 
word 2010 

Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng khoảng cách này không có 
trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn Line Spacing 
Options, và nhập vào khoảng cách mà bạn thích. 

A. Định dạng văn bản 
In đậm 
1. Chọn đoạn text mà bạn muốn in đậm, đưa con trỏ chuột vào vùng chọn cho 
đến khi xuất hiện thanh công cụ Mini. 

 

2. Nhấn nút Bold (B). 
Bạn cũng có thể sử dụng phím tắt Ctrl+B. 
Lưu ý : nhấn Bold (hoặc Ctrl+B) lần nữa nếu bạn muốn bỏ in đậm. 
In nghiêng 
Thực hiện tương tự như in đậm, nhưng thay vì nhấn nút Bold thì bạn nhấn nút 
Italic (phím tắt Ctrl+I). 
Gạch dưới đoạn text 
Nhấn Ctrl+U để gạch dưới đoạn text đang chọn. Nhấn Ctrl+U lần nữa để bỏ gạch 
dưới. 
Ngoài ra còn có nhiều kiểu gạch dưới khác: 
♦ Gạch dưới các từ, trừ khoảng trắng: 
- Chọn đoạn text bạn muốn gạch dưới. 
- Tới thẻ Home, nhóm Font, bạn nhấn nút mũi tên ở góc dưới bên phải. 

 

- Trong hộp Underline style, bạn chọn Word only. Nhấn OK. 
♦ Gạch đôi ở dưới từ: 
Thực hiện bước 1, 2 tương tự trên. 
Trong hộp Underline style, bạn chọn biểu tượng dòng đôi. Nhấn OK. 



 

 

♦ Đường gạch dưới trang trí: 
Thực hiện bước 1, 2 tương tự trên. 
- Trong hộp Underline style, bạn chọn kiểu mình thích. 
- Để đổi màu của đường gạch dưới, nhấn chuột vào hộp Underline color và chọn 
màu mình thích. Nhấn OK. 
Đổi màu chữ 
1. Chọn đoạn text bạn muốn đổi màu, di chuyển con trỏ chuột vào vùng chọn để 
xuất hiện thanh công cụ Mini. 
2. Nhấn nút Font Color và chọn màu mình thích. 
Đổi kích cỡ chữ 
1. Chọn đoạn text, di chuyển con trỏ chuột vào để xuất hiện thanh công cụ Mini. 
2. Để tăng kích cỡ chữ, bạn nhấn nút Grow Font (phím tắt Ctrl+Shift+>). Để giảm 
kích cỡ chữ, nhấn nút Shrink Font (phím tắt Ctrl+Shift+<). 
Đánh dấu (High ight) đọan text 
Đánh dấu đoạn text để làm nó trông nổi bật hơn. Cách thực hiện: 
1. Tới thẻ Home, nhóm Font, bạn nhấn vào mũi tên bên cạnh nút Text Highlight 
Color. 
2. Chọn một màu dùng để tô sáng mà bạn thích (thường là màu vàng). 
3. Dùng chuột tô chọn đoạn text muốn đánh dấu. 
4. Muốn ngừng chế độ đánh dấu, bạn nhấn chuột vào mũi tên cạnh nút Text 
Highlight Color, chọn Stop Highlighting, hoặc nhấn ESC. 
Gỡ bỏ chế độ đánh dấu text 
1. Chọn đoạn text muốn gỡ bỏ chế độ đánh dấu. 
2. Trong thẻ Home, nhóm Font, bạn nhấn chuột vào mũi tên cạnh nút Text 
Highlight Color. 
3. Chọn No Color. 
Định dạng chỉ số trên (Superscript), chỉ số dưới (Subscript) 
1. Chỉ số trên (Superscript); 
2. Chỉ số dưới (Subscript). 

 

Chọn đoạn text cần định dạng. Trong thẻ Home, nhóm Font, bạn nhấn nút 
Superscript (phím tắt Ctrl+Shift+=) để định dạng chỉ số trên, hoặc nhấn nút 
Subscript (phím tắt Ctrl+=) để định dạng chỉ số dưới. 



 

 

Canh chỉnh văn bản 
Canh trái, phải, giữa, hoặc canh đều hai bên 
1. Chọn đoạn văn bản bạn muốn canh chỉnh. 
2. Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh lề trái, nhấn 
Align Right để canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), hay 
nhấn nút Justify để canh đều hai bên. 
Canh chỉnh nhiều chế độ trên cùng 1 dòng 
1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout (Trong thẻ View, 
nhóm Document Views, chọn nút Print Layout hoặc Web Layout). 
2. Nhấn chuột vào dòng mới và thực hiện như sau: 
- Chèn đoạn text canh trái: Di chuyển con trỏ chuột chữ I sang trái cho đến vị trí 
cần gõ text, nhấn đúp chuột và gõ vào đoạn text. 
- Chèn đoạn text canh giữa: Di chuyển con trỏ chuột chữ I vào khoảng giữa dòng 
cho đến vị trí cần gõ text. Nhấn đúp chuột và gõ vào đoạn text. 
- Chèn đoạn text canh phải: Di chuyển con trỏ chuột chữ I sang phải cho đến vị trí 
cần gõ text, nhấn đúp chuột và gõ vào đoạn text. 
Thay đổi các canh chỉnh theo chiều dọc đoạn text 
1. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 
dưới bên phải. 
2. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical alignment, 



 

 

bạn chọn một loại canh chỉnh mình thích (Top, Center, Justified, Bottom). 

 

3. Tại mục Apply to, bạn chọn phạm vi áp dụng là Whole document (toàn văn 
bản), This section (vùng hiện tại), hay This point forward (kể từ đây trở về sau). 
Nhấn OK. 
Canh giữa lề trên và lề dưới 
1. Chọn đoạn văn bản bạn muốn canh giữa so với lề trên và lề dưới. 
2. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 
dưới bên phải. 
3. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical alignment, 
bạn chọn Center. 
4. Tại mục Apply to, chọn Selected text. Nhấn OK. 
Thụt về dòng đầu tiên của đoạn 
1. Nhấn chuột vào đoạn mà bạn muốn thụt lề dòng đầu tiên. 
2. Trong thẻ Page Layout, nhấn vào nút mũi tên góc dưới bên phải của nhóm 
Paragraph. 
3. Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục Special, bạn 



 

 

chọn First line. Tại mục By, chọn khoảng cách thụt vào. Nhấn OK. 
Điều chỉnh khoảng cách thụt lề của toàn bộ đoạn 
1. Chọn đoạn văn bản muốn điều chỉnh. 
2. Tại thẻ Page Layout, nhóm Paragraph, nhấn chuột vào mũi tên lên, xuống bên 
cạnh mục Left để tăng, giảm khoảng cách thụt lề trái, hay tới mục Right để điều 
chỉnh thụt lề phải. 
Thụt dòng tất cả, trừ dòng đầu tiên của đoạn 
1. Chọn đoạn văn bản mà bạn muốn điều chỉnh. 
2. Trên thanh thước ngang, hãy nhấn chuột vào dấu Hanging Indent và rê đến vị trí 
bạn muốn bắt đầu thụt dòng. 
Nếu bạn không thấy thanh thước ngang đâu cả, hãy nhấn nút View Ruler ở phía 
trên của thanh cuộn dọc để hiển thị nó. 
Tạo một thụt âm 
Thay vì thụt dòng vào trong, bạn có thể điều chỉnh thụt ra ngoài so với lề trái bằng 
cách: 
1. Chọn đoạn văn bản mà bạn muốn mở rộng sang trái. 
2. Tại thẻ Page Layout, nhóm Paragraph, nhấn nút mũi tên hướng xuống trong mục 
Left cho đến khi đoạn văn bản nằm ở vị trí bạn vừa ý. 
Thay đổi khoảng cách trong văn bản 
Tạo khoảng cách đôi giữa các dòng cho toàn bộ tài liệu 
Khoảng cách mặc định giữa các dòng cho bất kỳ tài liệu trống nào là 1.15. Bạn có 
thể tạo khoảng cách đôi (2) nếu muốn bằng cách sau: 
1. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào nút Normal, chọn Modify. 

 

2. Bên dưới nhóm Formatting, nhấn nút Double Space. Nhấn OK. 
Thay đổi khoảng cách dòng cho đoạn văn bản đang chọn 
1. Chọn đoạn văn bản muốn thay đổi. 
2. Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing. 
3. Chọn khoảng cách bạn muốn, chẳng hạn 2.0. 
Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng khoảng cách này 
không có trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn Line 
Spacing Options, và nhập vào khoảng cách mà bạn thích. 



 

 

Các kiểu khoảng cách dòng mà Word hỗ trợ: 
- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong dòng đó, thêm vào 
một lượng khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung tùy thuộc vào 
font chữ mà bạn đang sử dụng. 
- 1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn. 
- Double: Gấp 2 lần khoảng cách dòng đơn. 
- At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần thiết để phù hợp 
với font hoặc đồ họa lớn nhất trên dòng. 
- Exactly: Cố định khoảng cách dòng và Word sẽ không điều chình nếu sau đó bạn 
tăng hoặc giảm cỡ chữ. 
- Multiple: Xác lập khoảng cách dòng tăng hoặc giảm theo tỉ lệ % so với dòng đơn 
mà bạn chỉ định  

Thay đổi khoảng cách trước hoặc sau các đoạn  

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó. 

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh mục 
Before (trước) hoặc After (sau) để thay đổi bằng giá trị bạn muốn. 

Thay đổi khoảng cách giữa các ký tự  

1. Chọn đoạn văn bản mà bạn muốn thay đổi. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 
mở hộp thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn 
Expanded để mở rộng hay Condensed để thu hẹp khoảng cách và chỉ định số 
khoảng cách trong mục By. 

 

  



 

 

Co dãn văn bản theo chiều ngang  

1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 
mở hộp thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào tỉ lệ 
% mà bạn muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo ra, 
ngược lại, nó sẽ được thu lại. 

Đánh dấu sự thay đổi và ghi chú trong tài liệu  

Theo dõi sự thay đổi trong khi chỉnh sửa 

1. Mở tài liệu mà bạn muốn theo dõi. 

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes. 

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản…). 
Lập tức ở bên hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay đổi 
này. 

Tắt chế độ theo dõi sự thay đổi  

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa để tắt 
chế độ theo dõi trong khi chỉnh sửa. 

Thay đổi cách Word đánh dấu  

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi trong 
tài liệu bằng cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn chọn 
mục Change Tracking Options. 

  

- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị 
những bong bóng bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, sau 
đó chọn Show all revisions inline. 

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút 
Show Markup và chọn Markup Area Highlight. 



 

 

2. Định dạng cột, tab, Numbering 

a. Định dạng cột  

Cách thứ nhất: gõ văn bản trước, chia cột sau: 

- Bước 1: bạn nhập văn bản một cách bình thường, hết đoạn nào thì nhấn Enter để 
xuống hàng. Sau khi đã gõ hết nội dung văn bản, bạn hãy nhấn Enter để con trỏ 
xuống hàng tạo một khoảng trắng. 

- Bước 2: tô khối nội dung cần chọn (không tô khối dòng trắng ở trên), tại thẻ Page 
Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên ấn định. 

 

  

Nhấn vào More Columns hiển thị hộp thoại; 



 

 

 

  

- Presets : các mẫu chia cột 

- One – Two – Three : Các cột có độ rộng bằng nhau 

- Left – Right : Các cột có độ rộng khác nhau 

- Number of Columns : Số cột (nếu muốn số cột chữ ɯ) 

- Line Between: : Đường kẻ giữa các cột 

- Width and Spacing : Điều ch nh độ rộng và khoảng cách 

- Equal column width : Các cột có độ rộng cột bằng nhau nếu nhắp chọn vào ô 
vuông phía trước 

Cách thứ hai: chia cột trước, gõ văn bản sau (dùng trong trường hợp toàn bộ văn 
bản được chia theo dạng cột báo). 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên 
ấn định 



 

 

- Nhập văn bản vào. 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn Breaks, Column Break: để ngắt 
cột khi bạn muốn sang các cột còn lại. 

 

  

b. Cài đặt điểm dừng tab (Tab stops) 

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang trên đỉnh 
tài liệu bằng cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc. 



 

 

 

  

Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô 
giao nhau giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho 
đến khi chọn được kiểu tab mong muốn, sau đó nhấn chuột vào thanh thước ngang 
nơi bạn muốn đặt tab. 

Tùy từng trường hợp có thể mà bạn có thể sử dụng một trong các loại tab sau: 

♦ Tab trái: Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải khi bạn 
nhập liệu. 

♦ Tab giữa:Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị trí đặt tab khi 
bạn nhập liệu. 

♦ Tab phải: Nằ m ở bạn phải cuối đoạn text. Khi bạn nhập liệu, đoạn text sẽ di 
chuyển sang trái kể từ vị trí đặt tab. 

♦ Tab thập phân: Khi đặt tab này, những dấu chấm phân cách phần thập phân sẽ 
nằm trên cùng một vị trí. 

♦ Bar Tab: Loại tab này không định vị trí cho text. Nó sẽ chèn một thanh thẳng 
đứng tới vị trí đặt tab. 



 

 

 

  

- Default tab stops: Khoảng cách dừng của default tab, thông thường là 0.5″ 

- Tab stop position: gõ tọa độ điểm dừng Tab. 

- Alignment: chọn một loại tab là Left – Center – Right – Decimal – Bar (loại tab 
chỉ có tác dụng tạo một đuờng kẻ dọc ở một tọa độ đã định). 

- Leader :chọn cách thể hiện tab. 

+ 1 None Tab tạo ra khoảng trắng. 

+ 2-3-4 Tab tạo ra là các dấu chấm, dấu gạch hoặc gạch liền nét. 

- Các nút lệnh:  

♦ Set : Đặt điểm dừng tab, tọa độ đã gõ được đưa vào danh sách. 

♦ Clear : xóa tọa độ đã chọn. 



 

 

♦ Clear all : xóa tất cả tọa độ điểm dừng tab đã đặt. 

Nếu bạn muốn đặt điểm dừng tab tại vị trí phù hợp mà không thể xác định chính 
xác khi nhấn chuột lên thanh thước ngang, hoặc bạn muốn chèn ký tự đặc biệt 
trước tab, bạn có thể dùng hộp thoại Tabs bằng cách nhấn đúp chuột vào bất kỳ 
điểm dừng tab nào trên thanh thước. 

Sau khi cài đặt điểm dừng tab xong, bạn có thể nhấn phím Tab để nhảy đến từng 
điểm dừng trong tài liệu. 

 

 



 

 

Định dạng văn bản trong Word 2007 
  

Định dạng văn bản là thao tác quan trọng đối với bất kỳ văn bản nào, giúp văn bản 

đẹp mắt và dễ đọc hơn, tuy nhiên công đoạn này sẽ làm mất của bạn không ít thời 

gian. Những thủ thuật dưới đây sẽ giúp bạn tiết kiệm đáng kể thời gian cho việc 

này. 

1. Xóa bỏ định dạng khi sao chép văn bản 

Khi chép vào Microsoft Word một đoạn văn bản từ các nguồn khác như trong một 

trang web, từ file Word, Excel hay PowerPoint, Microsoft mặc định giữ lại định 

dạng gốc của đoạn văn bản này. Nếu muốn đoạn văn bản này được định dạng theo 

văn bản đích thì hãy thực hiện các bước sau đây: 

1. Copy đoạn văn bản từ nguồn khác bằng tổ hợp Ctrl+C hoặc menu chuột phải 

> Copy. 

2. Tại văn bản đích, click Tab Home và nhấn mũi tên bên dưới nút Paste. 

3. Trong nhóm Clipboard, click vào tùy chọn Keep Text Only (hình chữ A 

đậm). 



 

 

 

Tuy nhiên nếu phải chọn nhiều đoạn văn bản khác nhau bằng cách này cũng làm 

mất của bạn khá nhiều thời gian. Lúc này, bạn hãy chỉnh sửa thiết lập mặc định của 

MS Word bằng cách sau: 

1. Click nút Office > Word Options. Tiếp đến chọn tab Advanced ở cột trái. 

2. Trong phần Cut, Copy and Paste, bạn chọn đặc tính phù hợp cho từng thao 

tác. Chẳng hạn, nếu muốn văn bản sao chép có định dạng của văn bản đích 

khi chép từ một website, thì ở dòng Paste from other programs, bạn chọn 

“Match Destination Formatting” 

3. Click Ok để hoàn tất. 

2. Ngắt phân đoạn 

Chia nhỏ một văn bản thành các phân đoạn (section) sẽ giúp bạn dễ dàng chỉnh sửa 

định dạng cho từng phần của văn bản mà không làm ảnh hưởng đến các phần khác. 

Chẳng hạn, nếu bạn muốn xoay ngang một trang trong khi các trang khác vẫn ở 

chiều dọc thì bạn có thể sử dụng chức năng này. Để ngắt một phân đoạn, nhấn vào 

tab Page Layout rồi click mũi tên xổ xuống bên cạnh nút Breaks. Bạn có những tùy 

chọn sau: 



 

 

 Next Page: Bắt đầu một phân đoạn khác ở trang tiếp theo. 

 Continuous: Bắt đầu một phân đoạn khác ở trang hiện tại. 

 Even Page: Bắt đầu một phân đoạn khác ở trang chẵn tiếp theo. 

 Odd Page: Bắt đầu một phân đoạn khác ở trang lẻ tiếp theo. 

3. Gõ hai chữ trên cùng một dòng 

Để gõ hai hay nhiều chữ trên cùng một dòng, thay vì chỉ gõ dấu cách đơn thuần, 

bạn hãy chèn một dấu cách đặc biệt bằng tổ hợp phím Ctrl+Shift khi gõ dấu cách. 

Khoảng cách giữa các chữ vẫn được giữ nguyên, nhưng hai chữ được ngăn bằng 

dấu cách trên sẽ luôn ở cùng một dòng, có thể dòng trên hoặc nếu không đủ chỗ, cả 

hai chữ sẽ bị đẩy xuống dòng dưới. 

4. Định dạng số thứ tự trong danh sách 

Chỉ định dạng số thứ tự trong danh sách là điều không phải ai cũng biết và đôi khi 

sẽ làm họ tốn nhiều thời gian để mày mò và chỉnh sửa. Để thoát khỏi tình trạng 

này, bạn hãy thực hiện các bước sau: 

1. Trên tab Home, click vào biểu tượng Show/Hide tại nhóm Paragraph. 

2. Bôi đen biểu tượng đánh dấu đoạn ở cuối dòng để hiện lên thanh định dạng. 

3. Chọn định dạng bạn muốn thiết lập. Như bạn có thể nhìn thấy trong hình 

dưới, chỉ số 3 đầu dòng thứ 3 chuyển màu. 

 



 

 

Để định dạng thêm các số hoặc ký tự đánh dấu thứ tự khác nhưng không phải tất 

cả, nhấn giữ nút Ctrl trong khi chọn các biểu tượng đánh dấu đoạn. Để dịnh dạng 

toàn bộ số thứ tự trong một danh sách, click vào bất kỳ số nào trong danh sách để 

đánh dấu cột số thứ tự, tiếp đến thiết lập định dạng bạn muốn. 

5. Loại bỏ định dạng 

Loại bỏ định dạng trong văn bản là việc không khó, nhưng phần lớn người dùng 

chọn cách thủ công nhất: chọn đoạn văn bạn muốn bỏ định dạng để hiện cửa sổ 

công cụ định dạng, muốn bỏ chọn định dạng nào bạn phải click một lần nữa vào 

định dạng đó. 

Nếu muốn loại bỏ toàn bộ định dạng, có một cách nhanh hơn nhiều: bôi đen đoạn 

văn bản muốn bỏ định dạng và nhấn tổ hợp Ctrl+Spacebar, còn nếu chỉ muốn loại 

bỏ các định dạng đoạn, bạn chỉ cần nhấn tổ hợpCtr+Q. 

6. Chỉnh lại khoảng cách giữa các dòng 

Mặc định Word 2007 và 2010 thiết lập khoảng cách 1.15 giữa các dòng. Nếu muốn 

sửa đổi khoảng cách này, thực hiện các bước sau: 

1. Click tab Home. 

2. Click phải chuột vào nút Normal trong nhóm Styles và chọn Modify. 

3. Chọn Paragraph từ menu Format. 

4. Trong phần Spacing, chuyển lại khoảng cách từ 1.15 thành bất kỳ số nào bạn 

muốn. 

5. Nhấn Ok. 



 

 

 

7. Đặt lại khoảng cách giữa các đoạn 

Cũng liên quan đến khoảng cách là việc thay đổi khoảng cách giữa các đoạn. 

Nhiều khi bạn thấy khoảng cách giữa các đoạn quá lớn mà không có cách nào xóa 

đi vì nó vốn không phải là một dòng trống. Nếu không muốn các đoạn cách quá xa 

nhau, bạn hãy thực hiện các bước sau: 

1. Click tab Home. 

2. Clich vào mũi tên ở rìa phải nhóm Paragraph. 

3. Đánh dấu vào tùy chọn Don’t Add Space Between Paragraphs Of The Same 

Style. 

4. Click nút Default. 

5. Nhấn Ok để hoàn tất 



 

 

 

8. Dùng chức năng Find and Replace để thay đổi định dạng 

Chức năng tìm kiếm và thay thế Find and Replace chắc hẳn được rất nhiều người 

sử dụng để chuyển đổi ký tự hàng loạt, nhưng có lẽ không nhiều người biết chức 

năng này còn có thể giúp bạn thay đổi định dạng. Chẳng hạn, bạn muốn đổi toàn 

bộ một từ nào đó từ in đậm sang in nghiêng, bạn có thể làm theo cách sau: 

1. Nhấn tổ hợp Ctr+H 

2. Đặt trỏ chuột ở ô Find What và nhấn nút More 

3. Chọn mục Font trong menu Format 

4. Chọn Bold trong danh sách Font Style và nhấn OK. 

5. Đặt trỏ chuột trong phần Replace With và nhấn nút More. 

6. Chọn mục Font trong menu Format. 

7. Chọn Italic trong danh sách Font Style và nhấn Ok. 



 

 

 

9. Xóa đường kẻ liền 

Nếu bạn gõ ba dấu trừ và nhấn Enter, Microsoft Word sẽ thay thế chúng bằng một 

đường kẻ liền từ trái sang phải. Đôi khi đường kẻ này khá ngoan cố mà bạn không 

làm cách nào xóa đi được. Điều này xảy ra khi bạn tạo ra đường kẻ này ngay dưới 

dòng text bất kỳ. 

Để nhanh chóng xóa đi đường kẻ này, click vào mũi tên xổ xuống bên cạnh công 

cụ Border trong nhóm Paragraph và chọn No Border như hình dưới đây. 



 

 

 

10. Định dạng với AutoCorrect 

AutoCorrect là chức năng giúp giảm lỗi chính tả khi gõ văn bản đồng thời giúp bạn 

thiết lập các từ gõ tắt. Một chức năng nữa của AutoCorrect là định dạng cho văn 

bản. Để lưu một định dạng vào AutoCorrect, bạn làm như sau: 

1. Gõ một đạn văn bản và định dạng cho nó. Chẳng hạn, gõ In Nghiêng và áp 

dụng định dạng in nghiêng. 

2. Bôi đen từ này. 

3. Click nút Office > Word Options rồi chọn tab Proofing ở bảng bên phải. 

4. Chọn nút AutoCorrect Options trong phần AutoCorrect Options. 

5. Đánh dấu vào tùy chọn Formatted Text trong phần With. 

6. Gõ ing trong mục Replace. 

7. Click Add và nhấn Ok. 



 

 

Kể từ này bất kỳ khi nào bạn gõ ing và nhấn Enter, từ đó sẽ chuyển thành từ In 

nghiêng với định dạng in nghiêng. 

 



 

 

CÁC THAO TÁC ĐỊNH DẠNG VĂN BẢN TRONG 

WORD 2007 

I. ĐỊNH DẠNG CHỮ Định dạng chữ bao gồm các định dạng sau: Định dạng Font 

chữ Định dạng cỡ chữ Định dạng kiểu chữ Định dạng màu chữ Định dạn màu nền 

của chữ  

1. Định dạng Font chữ:  

Để định dạng Font chữ ta thực hiện các bước sau: 

Bước 1: Chọn chữ hoặc khối các chữ cần định dạng 

Bước 2: Nháy mũi tên bên cạnh nút lệnh Font trong thẻ Home 

Bước 3: Chọn tên 1 Font thích hợp 

Minh họa định dạng chữ: 

 

2. Định dạng cỡ chữ: 

Bước 1: Chọn chữ hoặc khối các chữ cần định dạng 

Bước 2: Nháy mũi tên bên cạnh nút lệnh Font Size trong thẻ Home 

Bước 3: Chọn 1 số thích hợp 

Minh họa định dạng cỡ chữ: 

 

3. Định dạng kiểu chữ: 

Bước 1: Chọn chữ hoặc khối các chữ cần định dạng 

Bước 2: Nháy nút lệnh Font Style trong nhóm lệnh Font trong thẻ Home 

Minh họa định dạng kiểu chữ: 

 

4. Định dạng màu chữ: 

Bước 1: Chọn chữ hoặc khối các chữ cần định dạng 



 

 

Bước 2: Nháy mũi tên bên cạnh nút lệnh Font Color trong thẻ Home 

Bước 3: Chọn 1 màu thích hợp 

Minh họa định dạng màu chữ: 

 

5. Định dạng màu nền của chữ:Bước 1: Chọn chữ hoặc khối các chữ cần định 

dạng 

Bước 2: Nháy mũi tên bên cạnh nút lệnh Text Highlight Color trong thẻ Home 

Bước 3: Chọn 1 màu thích hợp 

Minh họa định dạng màu nền của chữ: 

 

II. ĐỊNH DẠNG ĐOẠN VĂN 

Định dạng đoạn văn bao gồm các định dạng sau: 

Định dạng căn lề 

Định dạng khoảng cách các đoạn 

Định dạng màu nền cho đoạn văn 

Định dạng đường viền cho đoạn văn 

Định dạng khoảng cách thụt đầu dòng 

Định dạng Bullets, Numbering và Mutilevel List 

Ẩn hiện đánh dấu đoạn văn 

Sắp xếp đoạn văn 

1. Căn lề đoạn văn:  

Để căn lề cho đoạn văn ta thực hiện các bước sau: 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần căn lề 

Bước 2: Nháy chọn 1 kiểu căn lề đoạn văn của nhóm lệnh Pararaph trong thẻ 

Home 

Minh họa căn lề đoạn văn: 

 



 

 

2. Định dạng khoảng cách các đoạn văn:  

Để định khoảng cách cho đoạn văn ta thực hiện các bước sau: 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần định khoảng cách (Giãn dòng) 

Bước 2: Nháy vào mũi tên bên cạnh nút lệnh Line Spacing của nhóm lệnh Pararaph 

trong thẻ Home 

Bước 3: Chọn 1 khoảng cách thích hợp 

Minh họa định khoảng cách các đoạn văn: 

 

3. Định dạng màu cho các đoạn văn:  

Để định màu cho các đoạn văn ta thực hiện các bước sau: 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần định màu 

Bước 2: Nháy vào mũi tên bên cạnh nút lệnh Shading của nhóm lệnh Pararaph 

trong thẻ Home 

Bước 3: Chọn 1 màu thích hợp 

Minh họa định màu các đoạn văn: 

 

 

4. Định dạng đường viền cho các đoạn văn:  

Để định đường viền cho các đoạn văn ta thực hiện các bước sau: 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần định đường viền 

Bước 2: Nháy vào mũi tên bên cạnh nút lệnh Bottom Border của nhóm lệnh 

Pararaph trong thẻ Home 

Bước 3: Chọn 1 mẫu thích hợp 

Minh họa định đường viền các đoạn văn: 

 

5. Định dạng khoảng cách thụt đầu dòng cho các đoạn văn:  

Để định khoảng cách thụt đầu dòng cho đoạn văn ta thực hiện các bước sau: 



 

 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn cần định khoảng cách thụt đầu dòng 

Bước 2: Nháy vào nút lệnh Decrease Indent hoặc Increase Indent của nhóm lệnh 

Pararaph trong thẻ Home để giảm hoặc để tang độ thụt đầu dòng 

Minh họa định khoảng cách thụt đầu dòng cho các đoạn văn: 

 

Giảm độ thụt đầu dòng của đoạn văn 

 

Tăng độ thụt đầu dòng của đoạn văn 

6. Định dạng Bullets, Numbering và Mutilevel List cho đoạn văn:  

Để định dạng Bullets, Numbering và Mutilevel List cho đoạn văn ta thực hiện các 

bước sau: 

Bước 1: Chọn 1 đoạn văn hoặc các đoạn văn 

Bước 2: Nháy vào mũi tên bên cạnh nút lệnh Bullets hoặc Numbering hoặc 

Mutilevel List trong nhóm lệnh Pararaph trong thẻ Home 

Bước 3: Chọn 1 kiểu thích hợp 

Minh họa việc thêm Bullets, Numbering và Mutilevel List của đoạn văn: 

Thêm Bullets: 

 

Thêm Numbering: 

 

Thêm Mutilevel List: 

 

 

7. Ẩn hiện đánh dấu đoạn văn trong toàn văn bản:  

Để hiện đánh dấu đoạn văn (trong trường hợp đang ẩn) ta thực hiện như sau: Nhấn 

chuột vào nút lệnh trong nhóm lệnh Pararaph trong thẻ Home 

Minh họa hiện đánh dấu đoạn văn: 



 

 

 

Để ẩn đánh dấu đoạn văn (trong trường hợp đang hiện) ta thực hiện như sau: Nhấn 

chuột vào nút lệnh trong nhóm lệnh Pararaph trong thẻ Home 

Minh họa ẩn đánh dấu đoạn văn: 

 

8. Sắp xếp đoạn văn trong toàn văn bản:  

Để sắp xếp các đoạn văn ta thực hiện như sau: Nhấn vào nút lệnh trong nhóm lệnh 

Pararaph trong thẻ Home. Khi đó một cửa sổ Sort Text xuất hiện, trong cửa sổ này 

bạn chọn các kiểu sắp xếp xong rồi nhấn OK, bạn sẽ thấy kết quả ngay. 

Cách xoá bỏ định dạng Formatting của đoạn văn bản trong Word  

Cách xoá bỏ định dạng Formatting của đoạn văn bản trong Word, huỷ bỏ định dạng văn bản,xóa bỏ 

định dạng trong word, định dạng văn bản như thế nào 

 

Khi bạn soạn thảo văn bản Word mà lại góp nhặt từng đoạn của những văn bản khác nhau, chắc chắn 

sẽ có tình trạng định dạng của chúng sẽ không thống nhất.  

 

 

Với Word 2003 

 



 

 

Sau khi Copy đoạn văn bản lẫn lộn nhiều định dạng. Bạn có thể mở 1 file mới để sử dụng chức năng 

Paste Special... của Word 2003. 

 

Chọn menu Edit --> Paste Special... 

 

 

 

Trong hộp thoại, chọn Unformatted Text hoặc Unformatted Unicode Text. Khi đó đoạn văn bản được 

dán vào sẽ trở về định dạng mặc định ban đầu. 

 

 

 

Trong Microsoft Word 2007 có chức năng gọi là Clear Formatting (xóa bỏ định dạng) 



 

 

 

Chức năng này sẽ gỡ bỏ tất cả các định dạng đã có trước đó và đưa về định dạng mặc định, chỉ có text 

thô. 

 

Để dùng chức năng này, bạn cần bôi đen đoạn văn bản muốn xóa định dạng, mở thẻ Home trên thanh 

Ribbon của Word 2007, rồi nhấn lên nút Clear Formatting trong nhóm Font. 

 

 

 

Ngoài 2 cách trên dành cho 2 phiên bản, có tổ hợp phím nóng cũng rất hiệu quả. Đó là bôi đen đoạn 

văn bản, nhấn đồng thời Ctrl + Space bar (phím cách). Theo mình cách này cũng rất hiệu quả. 

 



 

 

MS Word 2013: Định dạng văn bản. 

CANH CHỈNH VĂN BẢN  

Canh trái, phải, giữa, hoặc canh đều hai bên: 

1. Chọn đoạn văn bản bạn muốn canh chỉnh. 

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Align Left để canh lề trái, nhấn 

Align Right để canh phải, nhấn nút Center để canh giữa (giữa 2 lề trái và phải), 

hay nhấn nút Justify để canh đều hai bên. 

Canh chỉnh nhiều chế độ trên cùng 1 dòng: 

1. Chuyển chế độ xem văn bản là Print Layout hoặc Web Layout (Trong thẻ 

View, nhóm Document Views, chọn nút Print Layout hoặc Web Layout). 

2. Nhấn chuột vào dòng mới và thực hiện như sau: 

- Chèn đoạn text canh trái: Di chuyển con trỏ chuột chữ I sang trái cho đến vị trí 

cần gõ text, nhấn đúp chuột và gõ vào đoạn text. 

- Chèn đoạn text canh giữa: Di chuyển con trỏ chuột chữ I vào khoảng giữa dòng 

cho đến vị trí cần gõ text. Nhấn đúp chuột và gõ vào đoạn text. 

- Chèn đoạn text canh phải: Di chuyển con trỏ chuột chữ I sang phải cho đến vị trí 

cần gõ text, nhấn đúp chuột và gõ vào đoạn text. 

Canh chỉnh vị trí một văn bản: 



 

 

1. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 

dưới bên phải. 

2. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical 

alignment, bạn chọn một loại canh chỉnh mình thích (Top, Center, Justified, 

Bottom). 

3. Tại mục Apply to, bạn chọn phạm vi áp dụng là Whole document (toàn văn 

bản), This section (vùng hiện tại), hay This point forward (kể từ đây trở về sau). 

Nhấn OK. 

Canh giữa lề trên và lề dưới: 

1. Chọn đoạn văn bản bạn muốn canh giữa so với lề trên và lề dưới. 

2. Trong thẻ Page Layout, nhóm Page Setup, nhấn chuột vào nút mũi tên ở góc 

dưới bên phải. 

3. Trong hộp thoại Page Setup, nhấn vào thẻ Layout. Tại mục Vertical 

alignment, bạn chọn Center. 

4. Tại mục Apply to, chọn Selected text. Nhấn OK. 

Thụt lề dòng đầu tiên của đoạn: 

1. Nhấn chuột vào đoạn mà bạn muốn thụt lề dòng đầu tiên. 

2. Trong thẻ Page Layout, nhấn vào nút mũi tên góc dưới bên phải của nhóm 

Paragraph. 



 

 

3. Ở hộp thoại Paragraph, chọn thẻ Indents and Spacing. Tại mục Special, bạn 

chọn First line. Tại mục By, chọn khoảng cách thụt vào. Nhấn OK. 

Điều chỉnh khoảng cách thụt lề của toàn bộ đoạn: 

1. Chọn đoạn văn bản muốn điều chỉnh. 

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn chuột vào mũi tên lên, xuống bên 

cạnh mục Left để tăng, giảm khoảng cách thụt lề trái, hay tại mục Right để điều 

chỉnh thụt lề phải. 

Thụt dòng tất cả, trừ dòng đầu tiên của đoạn: 

1. Chọn đoạn văn bản mà bạn muốn điều chỉnh. 

2. Trên thanh thước ngang, hãy nhấn chuột vào dấu Hanging Indent và rê đến vị 

trí bạn muốn bắt đầu thụt dòng. Nếu bạn không thấy thanh thước ngang đâu cả, hãy 

nhấn nút View Ruler ở phía trên của thanh cuộn dọc để hiển thị nó. 

Tạo một thụt âm: Thay vì thụt dòng vào trong, bạn có thể điều chỉnh thụt ra ngoài 

so với lề trái bằng cách: 

1. Chọn đoạn văn bản mà bạn muốn mở rộng sang trái. 

2. Tại thẻ Page Layout, nhóm Paragraph, nhấn nút mũi tên hướng xuống trong 

mục Left cho đến khi đoạn văn bản nằm ở vị trí bạn vừa ý. 

THAY ĐỔI KHOẢNG CÁCH TRONG VĂN BẢN 

Tạo khoảng cách đôi giữa các dòng cho toàn bộ tài liệu: 



 

 

Khoảng cách mặc định giữa các dòng cho bất kỳ tài liệu trống nào là 1.15. Bạn có 

thể tạo khoảng cách đôi (2) nếu muốn bằng cách sau: 

1. Trong thẻ Home, nhóm Styles, nhấn chuột phải vào nút Normal, chọn Modify. 

2. Bên dưới nhóm Formatting, nhấn nút Double Space. Nhấn OK. 

Thay đổi khoảng cách dòng cho đoạn văn bản đang chọn: 

1. Chọn đoạn văn bản muốn thay đổi. 

2. Trong thẻ Home, nhóm Paragraph, nhấn nút Line Spacing. 

3. Chọn khoảng cách bạn muốn, chẳng hạn 2.0 

Ghi chú: Nếu muốn đặt nhiều khoảng cách giữa các dòng nhưng khoảng cách này 

không có trong menu xuất hiện khi nhấn nút Line Spacing, bạn hãy chọn Line 

Spacing Options, và nhập vào khoảng cách mà bạn thích. 

Các kiểu khoảng cách dòng mà Word hỗ trợ:  

- Single (dòng đơn). Tùy chọn này hỗ trợ font lớn nhất trong dòng đó, thêm vào 

một lượng khoảng trống nhỏ bổ sung. Lượng khoảng trống bổ sung tùy thuộc vào 

font chữ mà bạn đang sử dụng. 

- 1.5 lines: Gấp 1,5 lần khoảng cách dòng đơn. – Double: Gấp 2 lần khoảng cách 

dòng đơn. – At least: Lựa chọn này xác lập khoảng cách dòng tối thiểu cần thiết để 

phù hợp với font hoặc đồ họa lớn nhất trên dòng. 

- Exactly: Cố định khoảng cách dòng và Word sẽ không điều chỉnh nếu sau đó bạn 

tăng hoặc giảm cỡ chữ. 



 

 

- Multiple: Xác lập khoảng cách dòng tăng hoặc giảm theo tỉ lệ % so với dòng đơn 

mà bạn chỉ định. Ví dụ, nhập vào 1.2 có nghĩa là khoảng cách dòng sẽ tăng lên 

20% so với dòng đơn. 

Thay đổi khoảng cách trước hoặc sau các đoạn: 

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó. 

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh 

mục Before (trước) hoặc After (sau) để thay đổi bằng giá trị bạn muốn. 

Thay đổi khoảng cách giữa các ký tự: 

1. Chọn đoạn văn bản mà bạn muốn thay đổi. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 

mở hộp thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn 

Expanded để mở rộng hay Condensed để thu hẹp khoảng cách và chỉ định số 

khoảng cách trong mục By. 

Co dãn văn bản theo chiều ngang: 

1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 

mở hộp thoại Font. 



 

 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào tỉ 

lệ % mà bạn muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo ra, 

ngược lại, nó sẽ được thu lại. 

Đánh dấu sự thay đổi và ghi chú trong tài liệu Theo dõi sự thay đổi trong khi 

chỉnh sửa: 

1. Mở tài liệu mà bạn muốn theo dõi. 

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes. 

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản…). 

Lập tức ở bên hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay đổi 

này. 

Tắt chế độ theo dõi sự thay đổi  

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa để 

tắt chế độ theo dõi trong khi chỉnh sửa. 

Thay đổi cách Word đánh dấu: 

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi trong 

tài liệu bằng cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn chọn 

mục Change Tracking Options 

- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị 

những bong bóng bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, sau 

đó chọn Show all revisions inline. 



 

 

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút 

Show Markup và chọn Markup Area Highlight. 

Nguồn bài viết: http://www.itviet360.com/2013/01/dinh-dang-van-ban-word-2007-

2010-2013.html#ixzz2YVo4ZSXO 

  

ĐỊNH DẠNG FONT CHỮ:  

In đậm  

1. Chọn đoạn text mà bạn muốn in đậm, đưa con trỏ chuột vào vùng chọn cho đến 

khi xuất hiện thanh công cụ Mini. 

2. Nhấn nút Bold (B). Bạn cũng có thể sử dụng phím tắt Ctrl+B. Lưu ý, nhấn Bold 

(hoặc Ctrl+B) lần nữa nếu bạn muốn bỏ in đậm. 

In nghiêng: 

Thực hiện tương tự như in đậm, nhưng thay vì nhấn nút Bold thì bạn nhấn nút 

Italic (phím tắt Ctrl+I). 

Gạch dưới đoạn text Nhấn Ctrl+U để gạch dưới đoạn text đang chọn. Nhấn 

Ctrl+U lần nữa để bỏ gạch dưới. 

Ngoài ra còn có nhiều kiểu gạch dưới khác: 

* Gạch dưới các từ, trừ khoảng trắng: 

- Chọn đoạn text bạn muốn gạch dưới. 



 

 

- Tại thẻ Home, nhóm Font, bạn nhấn nút mũi tên ở góc dưới bên phải. 

- Trong hộp Underline style, bạn chọn Word only. Nhấn OK. 

* Gạch đôi ở dưới từ: Thực hiện bước 1, 2 tương tự trên. Trong hộp Underline 

style, bạn chọn biểu tượng dòng đôi. Nhấn OK. 

* Đường gạch dưới trang trí: Thực hiện bước 1, 2 tương tự trên. 

- Trong hộp Underline style, bạn chọn kiểu mình thích. 

- Để đổi màu của đường gạch dưới, nhấn chuột vào hộp Underline color và chọn 

màu mình thích. Nhấn OK. 

Đổi màu chữ: 

1. Chọn đoạn text bạn muốn đổi màu, di chuyển con trỏ chuột vào vùng chọn để 

xuất hiện thanh công cụ Mini.  

2. Nhấn nút Font Color và chọn màu mình thích. 

Đổi kích cỡ chữ: 

1. Chọn đoạn text, di chuyển con trỏ chuột vào để xuất hiện thanh công cụ Mini. 

2. Để tăng kích cỡ chữ, bạn nhấn nút Grow Font (phím tắt Ctrl+Shift+>). Để 

giảm kích cỡ chữ, nhấn nút Shrink Font (phím tắt Ctrl+Shift+<). 

Đánh dấu (Highlight) đoạn text: 

Đánh dấu đoạn text để làm nó trông nổi bật hơn. Cách thực hiện: 



 

 

1. Tại thẻ Home, nhóm Font, bạn nhấn vào mũi tên bên cạnh nút Text Highlight 

Color . 

2. Chọn một màu dùng để tô sáng mà bạn thích (thường là màu vàng). 

3. Dùng chuột tô chọn đoạn text muốn đánh dấu. 

4. Muốn ngừng chế độ đánh dấu, bạn nhấn chuột vào mũi tên cạnh nút Text 

Highlight Color, chọn Stop Highlighting, hoặc nhấn ESC. 

Gỡ bỏ chế độ đánh dấu text: 

1. Chọn đoạn text muốn gỡ bỏ chế độ đánh dấu. 

2. Trong thẻ Home, nhóm Font, bạn nhấn chuột vào mũi tên cạnh nút Text 

Highlight Color. 

3. Chọn No Color. 

Định dạng chỉ số trên (Superscript), chỉ số dưới (Subscript): 

1. Chỉ số trên (Superscript); 

2. Chỉ số dưới (Subscript). 

Chọn đoạn text cần định dạng. Trong thẻ Home, nhóm Font, bạn nhấn nút 

Superscript (phím tắt Ctrl+Shift+=) để định dạng chỉ số trên, hoặc nhấn nút 

Subscript (phím tắt Ctrl+=) để định dạng chỉ số dưới. 

THIẾT LẬP ĐỊNH DẠNG MẶC ĐỊNH CHO MS WORD 2013 



 

 

Ở phiên bản này sẽ không còn tồn tại tùy chọn Format > Font > thiết lập định 

dạng > nhấn Default để dùng mặc định nữa. Trên MS Word 2013, ở thẻ HOME, 

bạn nhấn chuột phải lên nhóm định dạng Normal > chọn Modify > thiết lập những 

định dạng mặc định muốn dùng > đổi dấu chọn từ Only in this document (chỉ áp 

dụng lên văn bản hiện tại) sang New documents based on this template để các 

định dạng trên có hiệu lực với cả những văn bản tạo mới sau này. 

 

Mở chế độ thiết lập định dạng mặc định. 



 

 

 

Sử dụng định dạng cho mọi văn bản sẽ tạo sau này. 

Đây là một thủ thuật rất cần thiết cho người thường xuyên thiết lập văn bản, mà 

không cần căn chỉnh nhiều. Hãy chia sẻ với bạn bè nhé. 

Trích từ nguồn: http://www.thuthuat-it.com/2013/02/thiet-lap-inh-dang-mac-inh-

cho-ms-word.html#.UdtpYzunqcU 

  

HỦY ĐỊNH DẠNG VĂN BẢN: 



 

 

Có lẽ đây là trường hợp khá nhiều bạn gặp phải khi bạn Coppy một đoạn văn bản 

nào ở đâu đấy như ở trên mạng chẳng hạn và dán vào trình soạn thảo văn bản 

Word 2013 và nó không được định dạng theo cách bạn muốn, như là có đường 

gạch dưới chân hay các ký tự lạ lạ…Thủ thuật dưới sẽ giúp bạn có thể dễ dàng loại 

bỏ tất cả các định dạng từ văn bản và trả lại văn bản về mặc định một cách nhanh 

chóng. 

 

Để hủy bỏ định dạng không đồng nhất như đã nói ở trên bạn hãy chọn văn bản mà 

bạn muốn loại bỏ định dạng và nhấp vào Clear All Formatting trong phần Font 

của tab Home. Văn bản trở lại với định dạng mặc định bình thường. 



 

 

 
Bạn cũng có thể xóa hết định dạng trong các bài thuyết trình PowerPoint bằng cách 

trên. 



 

 

 

Một cách khác nhanh và khá đơn giản nữa để loại bỏ nhanh các định dạng trong 

Word và PowerPoint 2013 là để chọn văn bản cần xóa bỏ định dạng và nhấn Ctrl + 

Spacebar để loại bỏ tất cả các định dạng ký tự hoặc tổ hợp phím Ctrl + Q để loại 

bỏ chỉ định dạng đoạn. 

Chúc các bạn thành công ! 

 



 

 

Định dạng văn bản trong Word 2010 

 

Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô 

giao nhau giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho 

đến khi chọn được kiểu tab mong muốn, sau đó nhấn chuột vào thanh thước ngang 

nơi bạn muốn đặt tab. 

Thay đổi khoảng cách trước hoặc sau các đoạn 

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó. 

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh mục 

Before (trước) hoặc After (sau) để thay đổi bằng giá trị bạn muốn. 

Thay đổi khoảng cách giữa các ký tự 

1. Chọn đoạn văn bản mà bạn muốn thay đổi. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 

mở hộp thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn 

Expanded để mở rộng hay Condensed để thu hẹp khoảng cách và chỉ định số 

khoảng cách trong mục By. 



 

 

 

Co dãn văn bản theo chiều ngang 

1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để 

mở hộp thoại Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào tỉ lệ 

% mà bạn muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo ra, 

ngược lại, nó sẽ được thu lại. 

Đánh dấu sự thay đổi và ghi chú trong tài liệu 

Theo dõi sự thay đổi trong khi chỉnh sửa 

1. Mở tài liệu mà bạn muốn theo dõi. 

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes. 

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản…). 

Lập tức ở bên hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay đổi 

này. 

Tắt chế độ theo dõi sự thay đổi 



 

 

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa để tắt 

chế độ theo dõi trong khi chỉnh sửa. 

Thay đổi cách Word đánh dấu 

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi trong 

tài liệu bằng cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn chọn 

mục Change Tracking Options. 

- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị 

những bong bóng bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, sau 

đó chọn Show all revisions inline. 

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút 

Show Markup và chọn Markup Area Highlight. 

2. Định dạng cột, tab, Numbering 

a. Định dạng cột 

Cách thứ nhất: gõ văn bản trước, chia cột sau: 

- Bước 1: bạn nhập văn bản một cách bình thường, hết đoạn nào thì nhấn Enter để 

xuống hàng. Sau khi đã gõ hết nội dung văn bản, bạn hãy nhấn Enter để con trỏ 

xuống hàng tạo một khoảng trắng. 

- Bước 2: tô khối nội dung cần chọn (không tô khối dòng trắng ở trên), tại thẻ Page 

Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên ấn định. 



 

 

 

Nhấn vào More Columns hiển thị hộp thoại; 

 



 

 

- Presets : các mẫu chia cột 

- One – Two – Three : Các cột có độ rộng bằng nhau 

- Left – Right : Các cột có độ rộng khác nhau 

- Number of Columns : Số cột (nếu muốn số cột chữ ɯ) 

- Line Between: : Đường kẻ giữa các cột 

- Width and Spacing : Điều ch nh độ rộng và khoảng cách 

- Equal column width : Các cột có độ rộng cột bằng nhau nếu nhắp chọn vào ô 

vuông phía trước 

Cách thứ hai: chia cột trước, gõ văn bản sau (dùng trong trường hợp toàn bộ văn 

bản được chia theo dạng cột báo). 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên 

ấn định 

- Nhập văn bản vào. 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn Breaks, Column Break: để ngắt 

cột khi bạn muốn sang các cột còn lại. 



 

 

 

b. Cài đặt điểm dừng tab (Tab stops) 

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang trên đỉnh 

tài liệu bằng cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc. 



 

 

 

Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô 

giao nhau giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho 

đến khi chọn được kiểu tab mong muốn, sau đó nhấn chuột vào thanh thước ngang 

nơi bạn muốn đặt tab. 

Tùy từng trường hợp có thể mà bạn có thể sử dụng một trong các loại tab sau: 

♦ Tab trái: Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải khi bạn 

nhập liệu. 

♦ Tab giữa:Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị trí đặt tab khi 

bạn nhập liệu. 

♦ Tab phải: Nằ m ở bạn phải cuối đoạn text. Khi bạn nhập liệu, đoạn text sẽ di 

chuyển sang trái kể từ vị trí đặt tab. 

♦ Tab thập phân: Khi đặt tab này, những dấu chấm phân cách phần thập phân sẽ 

nằm trên cùng một vị trí. 

♦ Bar Tab: Loại tab này không định vị trí cho text. Nó sẽ chèn một thanh thẳng 

đứng tới vị trí đặt tab. 



 

 

 

- Default tab stops: Khoảng cách dừng của default tab, thông thường là 0.5″ 

- Tab stop position: gõ tọa độ điểm dừng Tab. 

- Alignment: chọn một loại tab là Left – Center – Right – Decimal – Bar (loại tab 

chỉ có tác dụng tạo một đuờng kẻ dọc ở một tọa độ đã định). 

- Leader :chọn cách thể hiện tab. 

+ 1 None Tab tạo ra khoảng trắng. 

+ 2-3-4 Tab tạo ra là các dấu chấm, dấu gạch hoặc gạch liền nét. 

- Các nút lệnh: 

♦ Set : Đặt điểm dừng tab, tọa độ đã gõ được đưa vào danh sách. 



 

 

♦ Clear : xóa tọa độ đã chọn. 

♦ Clear all : xóa tất cả tọa độ điểm dừng tab đã đặt. 

Nếu bạn muốn đặt điểm dừng tab tại vị trí phù hợp mà không thể xác định chính 

xác khi nhấn chuột lên thanh thước ngang, hoặc bạn muốn chèn ký tự đặc biệt 

trước tab, bạn có thể dùng hộp thoại Tabs bằng cách nhấn đúp chuột vào bất kỳ 

điểm dừng tab nào trên thanh thước. 

Sau khi cài đặt điểm dừng tab xong, bạn có thể nhấn phím Tab để nhảy đến từng 

điểm dừng trong tài liệu. 

 



 

 

 

Cách thay đổi hướng của văn 

bản trong word 2013 

  



 

Khi muốn thay đổi hướng của văn bản trong Word, bạn hãy làm theo 1 trong 2 

phương pháp được mô tả trong bài. 

 

1. Thay đổi hướng của văn bản trong hộp text-box hoặc shape (hình cơ bản 

định dạng sẵn) 

 

Muốn sử dụng hộp text-box hoặc shape để thay đổi hướng của văn bản, hãy sử 

dụng công cụ Text Box trong phần Text của tab Insert chèn hộp text-box hoặc sử 

dụng công cụ Shapes trong phần Illustrations của tab Insert để chèn shape > nhập 

văn bản vào hộp text-box hoặc shape. Hãy chắc chắn rằng hộp text-box hoặc shape 

được chọn > nhấp vào tab Format dưới Drawing Tools. 



 

 

Trong phần Text của tab Format, nhấp vào Text Direction > chọn một tùy chọn để 

xoay văn bản. Các biểu tượng bên cạnh từng tùy chọn cho bạn thấy cách văn bản 

sẽ hiển thị sau khi áp dụng tùy chọn đó. 



 

 

Văn bản bị xoay và hộp text-box được định hình lại cho phù hợp. 



 

 

Bạn cũng có thể chọn Text Direction Options từ menu thả xuống Text Direction để 

xoay văn bản. 



 

 

Chọn hướng từ phần Orientation trên hộp thoại Text Direction. Hình ảnh xem 

trước sẽ hiển thị trong phần Preview ở phía bên phải của hộp thoại. Nhấn OK để 

chấp nhận lựa chọn của mình. 



 

 

2. Thay đổi hướng văn bản trong các ô của bảng 

 

Bạn cũng có thể thay đổi hướng văn bản trong một hoặc nhiều ô của bảng. Để làm 



như vậy, hãy chọn các ô mà bạn muốn thay đổi hướng văn bản > nhấp vào tab 

Layout dưới Table Tools. 

 

 

Bấm vào Text Direction trong phần Alignment của tab Layout. 



 

 

Mỗi khi bạn nhấp vào Text Direction, hướng văn bản lại thay đổi. Tiếp tục nhấp 

vào nút cho đến khi đạt được hướng mong muốn. 



 

 

Bạn cũng có thể nhấp chuột phải vào văn bản đã chọn trong các ô của bảng > chọn 

Text Direction từ menu popup để thay đổi hướng văn bản. 



ĐỊNH DẠNG VĂN BẢN 
A. Mục đích, yêu cầu: 

       1. Về kiến thức: 

            - Học sinh nắm được thế nào là định dạng văn bản và tại sao phải 

định dạng văn bản, giúp học sinh hiểu nội dung ba mức định dạng: định 

dạng kí tự, định dạng đoạn văn bản và định dạng trang. 

              - Giúp học sinh thực hiện được định dạng kí tự, định dạng đoạn văn 

bản và định dạng trang. 

        2. Về tư tưởng, tình cảm: 

             - Nhấn mạnh các vấn đề đã được học trong Microsoft Word. 

             - Giúp các em yêu thích và hứng thú đối với môn học .      

B. Phương pháp, phương tiện 

         1. Phương pháp 

              - Kết hợp các phương pháp giảng dạy như thuyết trình, vấn đáp, 

hình vẽ minh học và một số dụng cụ dạy học khác… 

         2. Phương tiện học tập 

              - Vở ghi lý thuyết  

              - Sách giáo khoa lớp 10 

              - Sách tham khảo (nếu có) 

C.Tiến trình lên lớp, nội dung bài giảng 

         I.  Ổn định lớp (1’) 

              - Yêu cầu lớp trưởng báo cáo sĩ số 

         II. Kiểm tra bài cũ và gợi động cơ (4’) 

              - Chúng ta kết hợp kiểm tra bài cũ và cho điểm với quá trình học 

bài mới. 



              - Ở bài trước chúng ta đã được làm quen với màn hình soạn thảo 

văn bản và các thao tác làm việc với Word. Soạn thảo văn bản thường gồm: 

gõ nội dung văn bản, định dạng, in ra. Định dạng văn bản là một thao tác  

quan trọng , vậy định dạng văn bản như thế nào ? Chúng ta sẽ được tìm hiểu 

thao tác này qua bài học ngày hôm nay : Định dạng văn bản.  

         III.Nội dung bài giảng 

TT Nội dung Hoạt động của thầy và trò Thời  

gian 
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Đặt vấn đề 

- Máy tính là một công cụ đắc 

lực giúp cho con người giải 

quyết các công việc một cách 

nhanh chóng, đặc biệt là việc 

soạn thảo văn bản trong công 

tác văn phòng . 

- Để tạo được một văn bản tốt 

thì việc trình bày văn bản vô 

cùng quan trọng. Hôm nay 

chúng ta sẽ đi tìm hiểu cách 

định dạng văn bản sao cho có 

một văn bản đẹp. 
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2 

Định dạng văn bản 

 - Định nghĩa: Định dạng văn 

bản là trình bày các văn bản 

nhằm mục đích cho văn bản 

được rõ ràng và đẹp, nhấn 

mạnh những phần quan trọng, 

Thuyết trình 

- Người soạn thảo văn bản phải 

quan tâm đến vấn đề gì để 

được một văn bản đẹp? 

- Ví dụ: ta muốn văn bản đều 

có chữ đậm hoặc nghiêng, có 
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giúp người đọc nắm bắt dễ 

hơn các nội dung chủ yếu của 

văn bản. 

 - Các lệnh định dạng: Định 

dạng kí tự, định dạng đoạn 

văn bản và định dạng trang. 

màu sắc thì sử dụng  các thuộc 

tính của định dạng kí tự. 

  

 

 

 

 

 

 

 

3 

Định dạng kí tự 

- Các thuộc tính cơ bản: 

phông chữ, kiểu chữ, cỡ chữ, 

màu sắc 

- Cách sử dụng: Muốn định 

dạng kí tự trước hết ta phải 

chọn nó rồi thiết đặt các 

thuộc tính định dạng kí tự 

như sau: 

    Cách1: Sử dụng lệnh 

Format->Font…để mở hộp 

thoại Font. 

    Cách 2: Sử dụng các nút 

lệnh trên thanh công cụ định 

dạng 

Thuyết trình 

- Các phiên bản Word khác 

nhau có thể khác nhau về vị trí 

của các thuộc tính và hình thức 

thể hiện nhưng ý nghĩa của 

chúng thì giống nhau. 

- Ở cách 1 chúng ta sẽ có được 

hộp thoại như hình 54. 

- Ở cách 2 ta sẽ được thanh 

công cụ như hình 55. 

- Câu hỏi vấn đáp: Theo các 

bạn ngoài hai cách trên ta có 

còn cách nào khác không để 

định dạng văn bản?  
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Định dạng đoạn văn bản 

- Các thuộc tính: căn lề, vị trí 

lề đoạn văn, khoảng cách đến 

đoạn văn trước và sau… 

- Cách sử dụng: muốn định 

Thuyết trình 

- Định dạng đoạn văn bản như 

thế nào? 

- Ở cách 1 ta sẽ có hộp thoại 

Paragraph như hình 56. 
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dạng đoạn văn bản trước hết 

ta xác định đoạn văn bản theo 

một trong các cách sau: 

Cách 1: Đặt con trỏ văn 

bản vào trong đoạn văn bản 

Cách 2: Chọn một phần  

đoạn văn bản 

Cách 3: Chọn toàn bộ đoạn 

văn bản. 

Sau khi xác định xong 

đoạn văn ta định dạng theo 

một trong các cách sau: 

Cách 1: Sử dụng lệnh 

Format->Paragraph…để 

mở hộp thoại Paragraph 

  Cách 2: Sử dụng các nút 

lệnh trên thanh công cụ định 

dạng 

- Ở cách 2 ta sẽ có thanh công 

cụ như hình vẽ 57 

- Ngoài ra ta còn sử dụng các 

con trượt trên thước ngang như 

hình 58 

- Muốn làm tăng khoảng cách 

giữa các đoạn văn ta không nên 

nhấn phím Enter mà nên dùng 

lệnh Format->Paragraph...rồi 

tiếp đó điều chỉnh khoảng cách 

theo ý muốn. 

- Câu hỏi vấn đáp: Tại sao cần 

có các khoảng cách tới đoạn 

văn bản trên và đoạn văn bản 

dưới? 
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Định dạng trang 

- Thuộc tính cơ bản: Kích 

thước và hướng giấy 

- Cách sử dụng: Sử dụng lệnh 

File->Page Setup…để mở 

hộp thoại Page Setup 

Thuyết trình 

- Định dạng trang như thế nào? 

- Ở hình 59 cho ta thấy các 

thuộc tính định dạng trang. 

- Ở hình 60 cho ta thấy được 

hộp thoại Page Setup 

- Câu hỏi vấn đáp: Hướng giấy 

nằm ngang thích hợp cho 
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những loại văn bản nào? 

 

         IV. Củng cố bài ( 1’) 

 Giờ học hôm nay chúng ta đã được làm quen với các lệnh định 

dạng văn bản 

- Định dạng kí tự 

- Định dạng đoạn văn bản  

- Định dạng trang 

 Ta cần ghi nhớ các thuộc tính và các nút lệnh tương ứng của 

từng loại định dạng văn bản để vận dụng cho phù hợp đối với 

từng dạng văn bản. 

 V. Bài tập về nhà và câu hỏi ôn tập (3’)    

         - Qua bài học chúng ta rút ra được mục đích của việc trình bày 

văn bản là gì ? Và cách sử dụng các lệnh của định dạng văn bản.. 

         - Câu hỏi và bài tập về nhà ( sgk/ tr114) 

         - Chuẩn bị trước bài thực hành số 7 (sgk/ tr113) 

VI. Nhận xét, rút kinh nghiệm giờ giảng 

 Nhận xét, đánh giá của giáo viên hướng dẫn. 

          Các hình vẽ sẽ sử dụng trong bài giảng 



 
      

 



      

                               
 

 

 

 

 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

Câu hỏi và bài tập : Định dạng văn bản 

 



1. Thế nào là định dạng văn bản? Các lệnh định dạng được phân loại 

như thế nào? 

Trả lời     

 Định dạng văn bản là trình bày các phần văn bản nhằm mục đích 

cho văn bản được rõ ràng và đẹp, nhấn mạnh những phần quan 

trọng, giúp người đọc nắm bắt dễ hơn các nội dung chủ yếu của 

văn bản. 

 Các lệnh định dạng được chia thành ba loại: định dạng kí tự, định 

dạng đoạn văn bản và định dạng trang. 

2. Hãy kể những khả năng định dạng kí tự? 

Trả lời    Muốn định dạng bất cứ kí tự nào thì trước đó ta phải chọn để 

đánh dấu phần kí tự muốn định dạng rồi áp dụng các thuộc tính định 

dạng cho những kí tự đó. 

 Cách 1:  Sử dụng lệnh Format ->Font… để mở hộp thoại Font  

 Cách 2: Sử dụng các nút lệnh trên thanh công cụ định dạng    

3. Hãy kể những khả năng định dạng đoạn văn bản. Về nguyên tắc, có 

thể xoá một đoạn văn bản mà không cần chọn đoạn văn bản đó được 

không? 

Trả lời: 

* Để định dạng văn bản cần xác định đoạn văn bản bằng một trong 

các cách sau: 

         - Đặt con trỏ văn bản vào trong đoạn văn bản 

         - Chọn một phần đoạn văn bản 

         - Chọn toàn bộ đoạn văn bản 

Ta định dạng bằng các cách sau:  

         - Sử dụng lệnh Format -> Paragraph …để mở hộp thoại 

Paragraph 



         - Sử dụng các công cụ trên thanh công cụ định dạng 

4. Hãy phân biệt lề trang văn bản và lề đoạn văn bản  

Trả lời: 

* Lề trang văn bản  gồm: +)Lề trên là khoảng cách từ mép trên của 

trang đến vị trí dòng đầu tiên.  

    +)Lề trái là khoảng cách từ mép trái của 

trang đến vị trí đầu dòng. 

    +)Lề phải là khoảng cách từ mép phải của 

trang đến vị trí cuối dòng. 

    +)Lề dưới là khoảng cách từ mép dưới của 

trang đến vị trí dòng cuối. 

* Lề đoạn văn bản gồm:  +)Lề trái là khoảng cách lùi vào về phía bên 

trái của chữ đầu tiên của dòng đó so với các dòng khác 

    +)Lề phải là khoảng cách lùi vào về phía 

bêb phải của chữ đầu tiên của dòng đó so với các dòng khác 

    



Định dạng file văn bản 

Nhiều khi bạn loay hoay không biết làm thế nào để quay được 1 trang ngang trong cả đống trang 

văn bản. Hoặc cứ mỗi lần tạo một file mới bạn lại phải định dạng lại lề văn bản cho trang mặc 

dù kích thước lề lần trước và sau không thay đổi,… Quản Trị Mạng sẽ hướng dẫn bạn cách định 

dạng lề trang, quay trang ngang, trang dọc v.v… 

* Căn lề văn bản bằng cách vào Filechọn Page Setup… (Alt + F U) xuất hiện hộp thoại Page 

Setup. 

- Chọn thẻ Margins (Alt + M) 

- Điền khoảng cách lề trang, nếu bạn chưa đổi lại đơn vị tính thì đơn vị tính mặc định là inch. 

- Top: Lề trên, Bottom: Lề dưới, Left: Lề trái, Right: Lề phải, Header: Tiêu đề trang, Footer: 

Chân trang 

- Thông thường Header và Footer sẽ không thay đổi, mặc định để kích thước là 1,27cm đối với 

định dạng là trang A4 

+ R Mirror margins: Nếu bạn muốn in 2 mặt có lề đối xứng nhau trên 1 tờ giấy 

+ R 2 pages per sheet: Nếu bạn muốn in 1 trang thành 2 tờ giấy. 

+ Apply to: Áp dụng cho: 

+ Whole document: Toàn bộ file văn bản 

+ This point forward: Áp dung cho trang sau kể từ vị trí con trỏ định vị 

Sau khi đặt lại các thông số cùa lề, nếu bạn muốn thiết lập định dạng lề này cho các file văn bản 

sau này thì kích vào nút Default… và trả lời OK. 

- Quay trang dọc, trang ngang 

Vào Filechọn Page Setup… (Alt+F U) 

Xuất hiện hộp thoại Page Setup 

Chọn thẻ Paper Size (Alt + S) 

Với phần Paper Size, Width và Height bạn nên để mặc định, 2 kích thước Width – Height bạn có 

thể thay đổi được, nhưng nếu thay đổi quá nhiều khi in sẽ phải chọn đúng loại và kích thước 

giấy, nếu không đúng văn bản in ra sẽ bị mất chữ. 

Orientation: Định hướng kiểu trang 

� Portrait: Quay dọc 

€  Landscape: Quay ngang 

Apply to: Áp dụng cho: 

- Whole document: Toàn bộ file văn bản 

- This point forward: Áp dung cho trang sau kể từ vị trí con trỏ định vị 

Sau khi đặt lại các thông số cùa lề, nếu bạn muốn thiết lập định dạng lề này cho các file văn bản 

sau này thì kích vào nút Default… và trả lời OK. 

Mẹo: Trong file văn bản có nhiều trang, bạn chỉ muốn quay ngang trang 1 hoặc 1 số trang ở giữa 

file văn bản: 

Đặt dấu định vị con trỏ ở điểm cuối cùng ở trang trước muốn quay ngang, 

Thực hiện thao tác quay ngang trang giấy lần lượt từng bước trên. Chú ý: Phần Apply to bạn cần 

chọn là This Point forward. Kết quả: Toàn bộ những trang sau vị trí con trỏ định vị sẽ được quay 

ngang. 

Tiếp theo để quay dọc lại các trang sau, bạn cũng cần đặt con trỏ ở vị trí cuối cùng của trang 

ngang (trước trang muốn quay dọc). Thực hiện thao tác quay dọc trang giấy và Phần Apply to 

cũng chọn là This Point forward. 

Sử dụng phím Ctrl + F2 (File Print Preview) để xem hình ảnh file văn bản trước khi in. 

Thiết lập tiêu đề trang, chân trang (header, footer) của trang chẵn riêng, trang lẻ riêng. 

Vào Filechọn Page Setup… (Alt+F U) 

Xuất hiện hộp thoại Page Setup ——————— 

Chọn thẻ Layout (Alt + L) 

Chọn R Different odd and even. (Cách đặt tiêu đề trang và chân trang chúng tôi sẽ hướng dẫn 

tiếp trong các phần sau) 



Muốn không có header, Footer ở trang đầu tiên của file văn bản 

Vào Filechọn Page Setup… (Alt+F U) 

Xuất hiện hộp thoại Page Setup 

Chọn thẻ Layout (Alt + L) 

Chọn R Different first page. 

II. Định dạng chỉ số 

1. Để viết công thức của nước H20. Bạn gõ H2O, quét chọn chữ số 2, bấm menu Format > Font. 

Đánh dấu chọn mục Subscript ở cửa sổ hiện ra, bấm OK. Hoặc sử dụng phím tắt gõ chữ H, bấm 

tổ hợp phím Ctrl + dấu =, gõ số 2, sau đó lại bấm tổ hợp phím Ctrl + dấu =, rồi gõ chữ O. 

2. Định dạng chỉ số mũ. 

Để soạn thảo A2 : Gõ A2, quét chọn số 2, bấm menu Format > Font, đánh dấu chọn mục 

Superscript, bấm OK. Hoặc sử dụng phím tắt: Gõ A, bấm tổ hợp 3 phím Ctrl, Shift và dấu =, gõ 

số 2, bấm Ctrl, Shift và dấu =/ 

3. Các định dạng đặc biệt khác 

Quét chọn vùng văn bản, bấm menu Format. Trong cửa sổ hiện ra,vừa đánh dấu chọn các mục 

trong phần Effects, vừa quan sát trong khung Preview bên dưới để tìm các loại hiệu ứng cần 

dùng, bấm OK. 

4. Định dạng bề rộng chữ 

Quét chọn văn bản, bấm menu Format > Font. Bấm thẻ Character Spacing. Bấm ô Scale, chọn 

giá trị %, bấm OK. 

5.Định dạng chữ hiệu ứng 

Định dạng này chỉ có tác dụng khi xem văn bản trong Word mà không in được. Quét chọn văn 

bản, bấm menu Format > Font. Bấm thẻ Text Effects, vừa bấm chọn một dạng hiệu ứng trong 

khung Animations vừa quan sát khung phía dưới để xem trước hiệu ứng, bấm OK 

Sử dụng phím tắt làm cho tốc độ xử lý văn bản đem lại hiệu quả và rất nhanh chóng trong việc 

soạn thảo văn bản. Bài trước chúng tôi đã hướng dẫn Tự in phím tắt sử dụng trong MS Word, 

tiếp theo Quản Trị Mạng giới thiệu về một số phím tắt thường xuyên sử dụng trong MS Word 

bằng tiếng Việt. 

6. Phím tắt 

Tác dụng 

• Ctrl+1 Giãn dòng đơn (1) 

• Ctrl+2 Giãn dòng đôi (2) 

• Ctrl+5 Giãn dòng 1,5 

• Ctrl+0 (zero) Tạo thêm độ giãn dòng đơn trước đoạn 

• Ctrl+L Căn dòng trái 

• Ctrl+E Căn dòng giữa 

• Ctrl+J Căn dòng chữ dàn đều 2 bên, thẳng lề 

• Ctrl+N Tạo file mới 

• Ctrl+O Mở file đã có 

• Ctrl+S Lưu nội dung file 

• Ctrl+O In ấn file 

• F12 Lưu tài liệu với tên khác 

• F7 Kiểm tra lỗi chính tả tiếng Anh 

• Ctrl+X Cắt đoạn nội dung đã chọn (bôi đen) 

• Ctrl+C Sao chép đoạn nội dung đã chọn 

• Ctrl+V Dán tài liệu 

• Ctrl+Z Bỏ qua lệnh vừa làm 



• Ctrl+Y Khôi phục lệnh vừa bỏ (ngược lại với Ctrl+Z) 

• Ctrl+Shift+S Tạo Style (heading) -> Dùng mục lục tự động 

• Ctrl+Shift+F Thay đổi phông chữ 

• Ctrl+Shift+P Thay đổi cỡ chữ 

• Ctrl+D Mở hộp thoại định dạng font chữ 

• Ctrl+B Bật/tắt chữ đậm 

• Ctrl+I Bật/tắt chữ nghiêng 

• Ctrl+U Bật/tắt chữ gạch chân đơn 

• Ctrl+M Lùi đoạn văn bản vào 1 tab (mặc định 1,27cm) 

• Ctrl+Shift+M Lùi đoạn văn bản ra lề 1 tab 

• Ctrl+T Lùi những dòng không phải là dòng đầu của đoạn văn bản vào 1 tab 

• Ctrl+Shift+T Lùi những dòng không phải là dòng đầu của đoạn văn bản ra lề 1 tab 

• Ctrl+A Lựa chọn (bôi đen) toàn bộ nội dung file 

• Ctrl+F Tìm kiếm ký tự 

• Ctrl+G (hoặc F5) Nhảy đến trang số 

• Ctrl+H Tìm kiếm và thay thế ký tự 

• Ctrl+K Tạo liên kết (link) 

• Ctrl+] Tăng 1 cỡ chữ 

• Ctrl+[ Giảm 1 cỡ chữ 

• Ctrl+W Đóng file 

• Ctrl+Q Lùi đoạn văn bản ra sát lề (khi dùng tab) 

• Ctrl+Shift+> Tăng 2 cỡ chữ 

• Ctrl+Shift+< Giảm 2 cỡ chữ 

• Ctrl+F2 Xem hình ảnh nội dung file trước khi in 

• Alt+Shift+S Bật/Tắt phân chia cửa sổ Window 

• Ctrl+¿ (enter) Ngắt trang 

• Ctrl+Home Về đầu file 

• Ctrl+End Về cuối file 

• Alt+Tab Chuyển đổi cửa sổ làm việc 

• Start+D Chuyển ra màn hình Desktop 

• Start+E Mở cửa sổ Internet Explore, My computer 

• Ctrl+Alt+O Cửa sổ MS word ở dạng Outline 

• Ctrl+Alt+N Cửa sổ MS word ở dạng Normal 

• Ctrl+Alt+P Cửa sổ MS word ở dạng Print Layout 

• Ctrl+Alt+L Đánh số và ký tự tự động 

• Ctrl+Alt+F Đánh ghi chú (Footnotes) ở chân trang 

• Ctrl+Alt+D Đánh ghi chú ở ngay dưới dòng con trỏ ở đó 

• Ctrl+Alt+M Đánh chú thích (nền là màu vàng) khi di chuyển chuột đến mới xuất hiện chú 

thích 

• F4 Lặp lại lệnh vừa làm 

• Ctrl+Alt+1 Tạo heading 1 

• Ctrl+Alt+2 Tạo heading 2 

• Ctrl+Alt+3 Tạo heading 3 

• Alt+F8 Mở hộp thoại Macro 

• Ctrl+Shift++ Bật/Tắt đánh chỉ số trên (x2) 

• Ctrl++ Bật/Tắt đánh chỉ số dưới (o2) 

• Ctrl+Space (dấu cách) Trở về định dạng font chữ mặc định 

• Esc Bỏ qua các hộp thoại 

• Ctrl+Shift+A Chuyển đổi chữ thường thành chữ hoa (với chữ tiếng Việt có dấu thì không nên 

chuyển) 

• Alt+F10 Phóng to màn hình (Zoom) 

• Alt+F5 Thu nhỏ màn hình 



• Alt+Print Screen Chụp hình hộp thoại hiển thị trên màn hình 

• Print Screen Chụp toàn bộ màn hình đang hiển thị 

• Ngoài ra để sử dụng thanh Menu bạn có thể kết hợp phím Alt+ký tự gạch chân cũng sẽ xử lý 

văn bản cũng rất nhanh chóng, hiệu quả không kém gì tổ hợp phím tắt ở trên 

• Hy vọng rằng với bảng phím tắt này, bạn sẽ thao tác nhanh hơn đối với văn bản mà không gặp 

phải khó khăn gì! 

• Ctrl+Z, Ctrl+Y: tương đương với chức năng Undo và Redo trong Word nhưng cũng hiệu quả 

trong các phần mềm khác như Photoshop, Exel… 

• Ctrl+B, Ctrl+I, Ctrl+U: in đậm, in nghiêng, gạch chân các chữ đã bôi đen. 

• Ctrl+P: in những gì hiển thị trên cửa sổ. 

• Ctrl+Backspace: xóa cả từ thay vì từng chữ cái. 

• Ctrl+Shif+mũi tên ―lên‖, ―xuống‖: chọn và bôi đen từng đoạn văn bản. 

• Ctrl+Enter: chèn trang vào Word. 

• Chèn biểu tượng: Alt+Ctrl+C để có kí hiệu ©, Alt+Ctrl+R để có ®, Alt+Ctrl+T cho ký hiệu ™ 

III. Thao tác nhanh với MS Office 

Office là một bộ phần mềm văn phòng nổi tiếng, đã làm rạng danh tên tuổi cho Microsoft. Bộ 

phần mềm này rất lớn, người sử dụng Office chỉ sử dụng ít hơn 15% tính của bộ phần mềm 

chiếm tới 245 MB này. Thậm chí, với 15% đó, chúng ta cũng không biết rõ những tính năng bên 

trong, phím tắt, thủ thuật thao tác nhanh, các tài liệu về mánh khóe được công bố hay không 

công bố của Word, Excel, Outlook. 

Bạn có thể mua được hàng tấn sách đủ loại về các thủ thuật cho Office. Tuy nhiên, chúng sẽ là 

quá lớn và khó nhớ. chúng tôi xin cung cấp với bạn đọc một số thao tác cơ bản, giúp bạn tăng 

tốc trong công việc với Office 2003, XP và 2000. 

1. Tính năng phóng to, thu nhỏ của Office 

Nếu như chuột của bạn có nút cuộn, bạn có sử dụng nút cuộn để phóng to, thu nhỏ tài liệu. Bạn 

giữ <Ctrl> và cuộn chuột lên để phóng to, cuộn chuột xuống để thu nhỏ. Để cho các công cụ 

như Word và Excel làm việc tốt với tính năng này, bạn cần vào Tools-> Options, chọn thẻ 

General , và đánh dấu vào hộp chọn ―Zoom on Roll with Intellimouse box‖. 

2. Lối tắt tới lối tắt 

Nếu bạn không nhớ phím tắt, bạn muốn học và xem lại chúng? Quá đơn giản, Office sẽ giúp bạn 

nhanh chóng ―thuộc lòng‖ với những phím tắt này. Bạn hãy chọn Tools ->Customize, chọn vào 

thẻ Options, đánh dấu vào hộp chọn ―Show shortcut keys in ScreenTips‖. Bây giờ, mỗi lần bạn 

trỏ chuột qua một biểu tượng nào đó trong thanh công cụ, nó sẽ mô tả không chỉ chức năng của 

các biểu tượng đó mà còn hiện cả phím tắt cho bạn. 

3. Thao tác với Word Tự động với AutoText 

Word cung cấp tính tự động thay thế một cụm từ chỉ với một nhấn chuột thay vì phải gõ bằng 

tay. Để truy cập nhanh vào AutoText, bạn chỉ cần nhấn phải chuột vào bất cứ chỗ nào trên thanh 

công cụ, chọn AutoText. Bạn sẽ tìm thấy menu cho phép bạn chọn các cụm từ cũng như các 

cụm văn bản mà bạn tự thêm vào. 

Quay trở lại vị trí bạn vừa rời khỏi 

Bạn đang soạn thảo một văn bản dài, bạn chuyển sang ứng dụng khác vì một lý do nào đó. 

Nhưng khi quay lại văn bản đó thì bạn không biết chỗ đang gõ tiếp ở đâu, hoặc di chuyển tới 

chỗ đó khá mất thời gian. Bạn không biết phím tắt nào có thể giúp bạn đến đúng chỗ? Rất đơn 

giản, bạn chỉ cần giữ -. Thực ra, bạn có thể nhấn liên tiếp tổ hợp phím này để đến 3 nơi cuối 

cùng mà bạn đã tạo ra thay đổi. 

Hai cửa sổ trên một màn hình 

Khi bạn đang soạn thảo tài liệu, hoặc chỉ so sánh các đoạn khác nhau của một văn bản. Điều này 

thật hấp dẫn khi bạn có hai khung văn bản có thể trượt độc lập với nhau của cùng một văn bản. 

Bạn chọn Window -> Split. Một thanh split sẽ xuất hiện, bạn sử dụng chuột để di chuyển đường 

thẳng mà bạn muốn chia màn ra thành 2 phần và nhấn chuột. Bất kì thay đổi nào của một trong 2 
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khung nhìn này cũng sẽ thay đổi khung nhìn kia. Bạn muốn chuyển về chế độ một cửa sổ đơn 

như trước, bạn hãy nhấn đúp chuột vào thanh split. 

4.Thao tác với Excel (thay đổi hướng Enter ) 

Bạn có một bản tính có rất nhiều ô (cell), di chuyển giữa các ô nhanh nhất sẽ là rất có hiệu quả 

trong công việc. Một cách đơn giản nhất là bạn nhấn phím Enter. Mặc định, khi bạn nhấn Enter, 

con trỏ sẽ di chuyển xuống ô bên dưới. Nếu bạn không thích cách đó, bạn có thể thay đổi hướng 

mặc định theo ý mình. Bạn chọn Tools -> Options, chọn thẻ Edit chọn mục Move selection after 

Enter, bạn chọn hướng mình muốn, nhấn Ok. 

Để di chuyển từ bảng tính này sang bảng tính khác, bạn chỉ cần nhấn vào thẻ Sheet ở cuối màn 

hình. Nếu bạn muốn nhanh hơn, bạn chỉ cần nhấn tổ hợp – và – để chuyển đổi qua lại giữa các 

bảng tính. 

Sang trang với page break 

Nếu bạn đã từng in các bảng tính mà chỉ có vài cột và vài hàng sang trang một trang khác. Trông 

chúng thật xấu ! Phải làm cách nào để tránh vấn đề này ? Để xem khi nào bảng tính sẽ bị tách 

trang, bạn chọn View -> Page Break Preview. Nếu đây là lần đầu tiên bạn dùng chức năng này, 

bạn sẽ thấy màn hình ―chào hỏi‖ – màn hình này không thực sự hữu ích. Bạn hãy đánh dấu chọn 

vào hộp Do not to show it again để tắt màn hình này vào lần sử dụng sau. Bạn sử dụng thanh 

cuộn ngang và dọc để xem Excel tách trang như thế nào. Các trang sẽ được đánh dấu bằng một 

nhãn lớn và dòng kẻ page break sẽ được in đậm. Bạn có thể chỉnh dòng kẻ page break này bằng 

chuột. 

Để đặt page break bằng tay, bạn chọn ô sẽ ô đầu tiên của trang. Sau đó bạn chọn Insert -> Page 

Break. Sau này, muốn loại bỏ page break, bạn chọn Insert -> Remove Page Break. 

Sử dụng tính năng AutoFill 

Excel có thể tạo một dãy số tuần tự , ngày tháng, ngày trong tuần, tháng, năm. Để làm được điều 

này, bạn chỉ cần điền giá trị của 1 hoặc 2 giá trị của dãy tuần tự đó vào các ô và AutoFill sẽ tự 

động điền tiếp cho bạn. 

- Điền một dãy số : Để điền được một dãy số, bạn điền giá trị 1 vào một ô, giá trị 2 vào ô bên 

cạnh, và tiếp đó, bạn lựa chọn cả 2 ô. Bây giờ con trỏ của bạn sẽ là một biểu tượng hình dấu 

cộng (không phải dấu cộng với các mũi tên), bạn chỉ cần kéo từ đó cho đến chỗ bạn muốn. Bạn 

sẽ thấy các ô có giá trị tăng dần (3,4,5,…). Nếu bạn nhập vào 100, 200 bạn cũng sẽ có các giá trị 

300, 400, 500… 

- Điền ngày tháng: Cũng tương tự, nếu bạn điền một ngày trong tuần, hoặc một tháng trong năm, 

Excel có thể tự động điền giá trị bằng AutoFill. Nếu bạn nhập vào ngày cuối của tháng, AutoFill 

sẽ chuyển sang ngày đầu của tháng tiếp theo. Excel có thể điền một dãy các năm hoặc quý như 

2004, 2005,2006, hoặc Q1,Q2,Q3,Q4. 

Theo mặc định, AutoFill sẽ sao chép cả giá trị và định dạng của các ô mà bạn chọn. Để lựa chọn 

một trong hai, bạn hãy nhấn chuột phải khi kéo. Khi bạn thả chuột bạn sẽ thấy lựa chọn Fill 

Formatting Only hoặc Fill Without Formatting. Nếu bạn không thích cách mà AutoFill điền dữ 

liệu, bạn có thể chọn lựa mục AutoFill Smart Tag để có thêm nhiều tuỳ chọn hơn. 

5. Tạo phím tắt tùy chọn trong Word 

Đối với Word , bạn dễ dàng tạo cho mình những tổ hợp phím nóng giúp thực hiện nhanh tác vụ 

hơn là dùng chuột. Tính năng này rất hữu ích cho bạn tiết kiệm thời gian và chỉ có thể thực hiện 

đối với Word, không thể thực hiện trong PowerPoint hay Excel. 

Để thực hiện , bạn chọn vào menu Tools > Customize. Sau đó, chọn vào thẻ Commands. Click 

vào menu KeyBoard dưới góc phải để hiển thị hộp thoại Customize Keyboard. 

Trong phần Categories là các menu chính, và phần Commands là các menu phụ xổ xuống. Ví dụ 

muốn chọn tổ hợp phím cho tác vụ File > Save All thì bạn phải chọn phần categories là File và 

phần commands là FileSaveAll. 

Nếu hiện tại tác vụ đó đã có phím tắt thì tổ hộp phím đó sẽ hiển thị trong phần Current Keys. 

Còn nếu như tại phần Current Keys trống thì bạn có thể tự tạo tổ hợp phím tắt cho tác vụ tại 



Press New Shortcut Key. Lưu ý, bạn cũng có thể Replace tổ hợp phím cho phù hợp với nhu cầu 

sử dụng phím của mình bằng các tổ hợp phím trong phần Press New Shortcut Key. Sau đó nhấn 

vào Assign để hoàn tất việc thiết lập. Nhấn Close để hoàn tất. Từ bây giờ , bạn hoàn toàn có thể 

sử dụng tổ hợp phím hữu ích của riêng mình trong Word được rồi đấy. 

IV. 106 thủ thuật với Microsoft Office 

1. Tính toán trên bảng: Word không phải là một ứng dụng bảng tính chuyên nghiệp như Excel 

nhưng Word vẫn có khả năng thực hiện được những tính toán cơ bản trên bảng. 

Để tính toán trên bảng trong Word bạn hãy vào Table | Formula rồi lựa chọn một hàm tính toán. 

Tuy nhiên, số lượng các hàm tính toán trong Word là rất hạn chế, nhiều khi có thể sẽ làm bạn 

thất vọng. 

Ví dụ để tính toán trên hàng =SUM(LEF) 

Trong đó =SUM(LEF) không phải bạn nhập vào mà Word sẽ đưa ra gợi ý cho bạn khi bạn vào 

Table | Formula (hình minh hoạ). 

Ví dụ để tính toán trên cột =SUM(ABOVE) 

Bạn cũng có thể nhập các công thức tính toán đơn giản như kiểu trong Excel, ví dụ =A1*B2. 

Mặc dù tên của hàng và cột trong Word không hiện ra nhưng bạn yên tâm định dạng vẫn giống 

hệt như trong Excel. 

Để cập nhật kết quả tính toán khi có thay đổi bạn hãy lựa chọn ô chứa kết quả rồi ấn phím F9. 

Hoặc để cập nhật kết quả tính toán trong phạm vi toàn bảng, bạn hãy lựa chọn cả bảng rồi ấn 

phím F9. 

Tạo bảng nhanh chóng 

Khả năng tự động định dạng của Word giúp bạn nhiều khi không phải động đến chuột hay menu 

mà chỉ cần bàn phím là đủ. Tạo bảng nhanh chóng cũng là một thủ thuật như vậy. 

Để có thể tạo bảng nhanh chóng bạn chỉ cần kí tự dấu cộng (+) và kí tự dấu gạch ngang (-). Bạn 

chỉ cần nhập các kí tự này theo kiểu định dạng sau rồi ấn Enter, Word sẽ tự động tạo bảng ngay 

cho bạn. 

+———————+———————+———————+ 

Khoảng cách giữa hai dấu cộng (+) sẽ quyết định đến độ rộng của cột được tạo ra. 

Tắt tính năng tự động định dạng chỉ số trên-chỉ số dưới 

Nhiều khi bạn gặp rắc rối với tính năng tự động định dạng chỉ số trên (superscript) hoặc chỉ số 

dưới (subscript) của Word, nhất là bạn thường xuyên sử dụng tiếng nước ngoài với các kiểu kí 

tự như ―1st, 2nd, 3rd,…‖. Bạn không thích tính năng này thì hãy tắt nó đi bằng cách vào Tools | 

AutoCorrect Options rồi chuyển sang mục AutoFormat As You Type và bỏ đánh dấu trước mục 

Ordinals (1st) là ok. 

Tạo mẫu văn bản có ảnh xem trước 

Template – mẫu văn bản – là một chức năng vô cùng hữu ích trong Word. Chức năng này cho 

phép bạn tạo các văn bản định dạng theo một kiểu mẫu nhất định và có thể sử dụng lại nhiều lần. 

Lấy ví dụ bạn tạo ra một kiểu giấy mời của riêng bạn rồi lưu lại thành mẫu văn bản trong Word. 

Lần sử dụng sau bạn chỉ cần mở template đó ra rồi điền các thông tin cần thiết là được. 

Để tạo ra mẫu văn bản của riêng mình, trước tiên bạn hãy tạo một văn bản thông thường định 

dạng theo đúng mẫu văn bản cần thiết của bạn. Khi lưu văn bản bằng File | Save, bạn hãy chọn 

Document Template (*.dot) trong mục Save as type của cửa sổ lưu văn bản. Để mẫu văn bản 

của bạn có hình ảnh xem trước thì trước khi lưu thành định dạng template bạn hãy vào File | 

Properties rồi đánh dấu vào Save Preview Picture. 

Để sử dụng template bạn vừa tạo ra, hãy vào File | New chờ khi bảng nhiệm vụ (Task pane) hiện 

ra bên tay phải bạn chọn General Templates trong mục New from template và nhớ đánh dấu vào 

mục Document và lựa chọn template của bạn đã tạo ra – hình ảnh xem trước của mẫu văn bản sẽ 

hiện ra trong khung Preview. 

Giấu tên văn bản trong Recently Used Files 

Thông thường Word lưu lại tên và đường dẫn các văn bản được sử dụng gần đây tại danh sách 

Recently used file. Để truy cập đến danh sách này bạn chỉ cần vào menu File sẽ thấy danh sách 

các tệp tin văn bản được liệt kê theo thứ tự 1,2,3,4… Mặc định số tệp tin văn bản được lưu tại 
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danh sách này là 4. Bạn có thể chỉnh con số này lên hoặc giấu không cho hiện tên những văn 

bản này bằng cách sau đây. 

Bạn vào Tools | Options và chuyển sang mục General. Trong mục này bạn để ý đến dòng 

Recently used file list. Để tăng số văn bản trong danh sách Recently used files bạn chỉ cần thay 

đổi con số trong ô ngay bên cạnh. Còn để không cho hiện danh sách này bạn hãy bỏ đánh dấu 

chọn mục này, nhắp OK. 

V. 106 thủ thuật với Microsoft Office 

Track changes – So sánh các văn bản 

Bạn có 2 văn bản giống hệt nhau và bạn muốn so sánh xem chúng giống và khác nhau ở điểm 

nào? Thay vì phải ngồi so sánh từng dòng một, thủ thuật sau đây có thể sẽ giúp bạn thực hiện 

công việc này một cách nhanh chóng. 

Nếu bạn đã biết sử dụng tính năng Track changes trong Word thì thật là tiện dụng. Tính năng 

này sẽ giúp bạn theo dõi và ghi lại rõ ràng mọi sự thay đổi trong văn bản của bạn. Để bật tính 

năng Track changes bạn hãy vào Tool | Track Changes hoặc sử dụng phím tắt Ctrl-Shift-E. 

Còn nếu bạn đã không bật Track changes từ trước thì làm thế nào để có thể tìm ra mọi thay đổi 

khác biệt trong 2 văn bản đây. Vẫn có cách, vẫn là Trach changes giúp bạn giải quyết mọi việc. 

Trong Word 2000, bạn hãy vào Tools | Track changes | Compare documents. Khi hộp thoại bật 

ra bạn hãy lựa chọn văn bản bạn cần đem ra so sánh với văn bản hiện thời của bạn. Word sẽ giúp 

bạn bổ sung những gì đã được thay đổi vào trong văn bản của bạn. 

Trong Word XP và 2003 thì có khác hơn một chút, bạn vào Tools | Compare and Merge 

Documents. Trong hộp thoại bật ra bạn hãy đánh dấu vào Legal blackline (ngay cạnh trường 

File name) để kích hoạt tính năng so sánh văn bản; nếu không Word sẽ giúp bạn hợp nhất 2 văn 

bản. Quá trình còn lại là giống với Word 2000. 

Split – So sánh nhiều phần của văn bản 

Văn bản của bạn dài hàng chục hàng trăm trang mà bạn lại muốn so sánh nhiều phần của trong 

văn bản đó với nhau – chẳng hạn phần mở đầu với phần kết luận? Split sẽ giúp bạn giải quyết 

khó khăn này. 

Bạn vào Windows | Split. Ngay lập tức con trỏ sẽ biến thành một đường kẻ ngang cho phép bạn 

chỉ định khoảng cách chia đôi màn hình trong Word. Hãy đặt sao cho thật dễ nhìn rồi nhắp chuột 

trái 1 lần. Word đã bị chia làm 2 cửa sổ riêng biệt và bạn có thể duyệt văn bản dễ dàng hơn. Để 

bỏ tính năng này bạn lại vào Windows và chọn Remove Split. 

Bảo vệ văn bản của bạn 

Có nhiều cách để bảo vệ văn bản của bạn – ngăn chặn người khác mở văn bản của bạn hoặc 

ngăn chặn người khác sửa đổi văn bản của bạn. 

Có những cách sau đây để bảo vệ văn bản của bạn. 

Bạn vào Tools | Options rồi chuyển sang mục Security – Bạn nhập mật khẩu vào mục Password 

to open để đặt mật khẩu ngăn chặn người khác mở văn bản của bạn. Nhập mật khẩu vào mục 

Password to modify để ngăn chặn người khác sửa đổi văn bản của bạn. 

Bạn vào Tools | Protect Document để có thêm tính năng bảo mật văn bản. Trong cửa sổ Protect 

Document bạn sẽ thấy 3 lựa chọn Track changes (chống mọi thay đổi với Track changes, người 

khác vẫn có thể đọc và sửa văn bản của bạn nhưng mọi thay đổi đó sẽ được ghi lại và menu 

Tools | Track Changes sẽ bị vô hiệu hoá), Comment (chỉ cho phép người khác được đọc văn bản 

của bạn và bổ sung thêm những nhận xét gọi ý – comment – vào chứ không được thay đổi văn 

bản) và Form (ngăn chặn mọi thay đổi trong văn bản chỉ cho phép thay đổi trong những phần 

văn bản không được bảo vệ hoặc trong các form hoặc trường) 

Đặt đường dẫn mặc định để lưu và mở văn bản 

Thông thường Word luôn chọn thư mục My Documents là thư mục mặc định để lưu và mở các 

văn bản của người sử dụng. Tuy nhiên, Word cũng cho phép người sử dụng có thể thay đổi mặc 

định. 

Bạn vào Tools | Options rồi chuyển sang mục File locations. Trong cửa sổ này bạn nhắp chuột 

vào mục cần thay đổi. Ví dụ ở đây là thay đổi đường dẫn mở và lưu văn bản mặc định thì bạn 



nhắp chuột vào mục Documents sau đó nhắp chuột vào Modify và chỏ đến thư mục riêng của 

bạn. Nhắp ok là xong. 

Đặt font chữ mặc định 

Bạn quen sử dụng một loại font chữ nhất định và muốn lần nào mở Word ra thì đã sẵn sàng font 

chữ đó cho bạn rồi. Rất đơn giản, bạn hãy thử thủ thuật sau đây. 

Bạn mở bất kì một văn bản nào cũng được, vào Format | Font. Trong cửa sổ Font hiện ra bạn 

hãy chọn lựa đúng kiểu font chữ bạn quen dùng rồi nhắp chuột vào Default ở góc cuối bên tay 

trái của cửa sổ font, Word hỏi bạn có muốn đặt font chữ mặc định không, chọn Yes là xong. 

VI. 106 thủ thuật với Microsoft Office 

Vẽ một đường thẳng 

Bạn hoàn toàn có thể dễ dàng kẻ một đường thẳng ngang văn bản của mình một cách rất đơn 

giản như sau 

- Bạn gõ liên tiếp 3 dấu gạch ngang (-) rồi ấn Enter bạn sẽ có một đường kẻ đơn. 

- Bạn gõ liên tiếp 3 dấu gạch dưới (_) rồi ấn Enter bạn sẽ có một đường kẻ đậm 

- Bạn gõ liên tiếp 3 dấu bằng (=) rồi ấn Enter bạn sẽ có một đường kẻ đôi. 

Máy tính có sẵn trong Word 

Bạn có biết là bạn hoàn toàn có thể bổ sung thêm một máy tính vào trong Word không? Đúng 

hoàn toàn có thể và sẽ giúp bạn thêm phần thuận lợi trong công việc hơn rất nhiều. 

Trong MS Word vào View | Toolbars | Customize hoặc bạn có thể nhắp chuột phải lên bất kì 

thanh công cụ (toolbar) nào rồi chọn Customize. Trong cửa sổ Customize – bạn đã có cơ hội làm 

quen với cửa sổ này trong phần trước của bài viết – bạn hãy chọn Tools ở bên khung Categories 

bên tay trái và chọn biểu tượng Tool Calculate trong khung Commands bên tay phải. Bạn nhắp 

và giữ chuột trái lên biểu tượng của Tools Calculate rồi kéo và thả lên bất kì thanh công cụ nào 

mà bạn thích. 

Bây giờ bạn có dễ dàng thực hiện các phép tính trong Word bằng cách gõ vào phép tính của rồi 

lựa chọn toàn bộ phép tính, nhắp chuột vào Tools Calculate rồi ấn Ctrl-V để dán kết quả vào. 

Tuần hoá Smart Tags và Spelling, Track changes 

Bạn đã bao giờ bị các dòng gạch chân loằng ngoằng màu xanh màu đỏ làm phiền chưa? Bạn 

chưa biết là nó từ đâu xuất hiện? Nó chính là tính năng kiểm tra lỗi chính tả và kiểm tra lỗi ngữ 

pháp trong MS Word. Tính năng này chỉ có hiệu quả đối với các văn bản tiếng Anh còn đối với 

các văn bản tiếng Việt thì thật là một điều vô cùng phiền phức. Để loại bỏ phiền phức này bạn 

hãy vào Tools | Options rồi chuyển sang mục Spelling & Gammar. Trong mục này bạn bỏ dấu 

kiểm trước Check spelling as you type và Check grammar as you type, sau đó là Ok là xong. 

Smart Tags có thể nói là một trong những tính năng mới tương đối hiệu quả trong các phiên bản 

Word mới đây. Tuy nhiên nhiều lúc người sử dụng cũng thấy khó chịu về các tag ngày, số điện 

thoại, copy-paste… liên tục hiện ra. Nếu bạn không ưa Smart Tags hãy vào Tools | AutoCorrect 

Options và chuyển sang mục Smart Tags trong cửa sổ AutoCorrect Options và bỏ dấu kiểm 

trong những loại Smart Tag bạn không muốn hiện ra. 

Còn một tính năng nữa trong Word cũng có những dòng kẻ màu đỏ loằng ngoằng gây khó chịu 

rất nhiều đó là Track changes. Tính năng này thực sự có hiệu quả khi bạn để người khác sửa văn 

bản của bạn. Những thay đổi đó sẽ được Track changes ghi nhận và liệt kê ngay trong văn bản. 

Để bỏ đi bạn hãy vào View rồi bỏ đánh dấu trước Markup là xong. 

Status Bar có gì cho bạn? 

Bạn đã bao giờ để ý đến thanh trạng thái (Status bar) trong Word chưa? Nó cũng có khá nhiều 

điều thú vị đó. Nhưng nếu Word của bạn chưa hề có Status bar thì bạn hãy vào Tools | Options 

chuyển sang mục View. Trong mục này bạn để ý đến phần Show và đánh dấu kiểm vào Status 

bar là xong. 

Thanh trạng thái đúng như tên gọi của nó cho bạn thấy thông tin về văn bản của bạn, thứ tự 

trang hiện thời của bạn, phần, dòng, toạ độ con trỏ chuột …. Nhắp đúp chuột lên Số thứ tự của 

trang bạn sẽ gọi được menu Go to. 



Bên cạnh đó, trên thanh trạng thấy bạn còn thấy có REC – TRK – EXT – OVR. Nhắp đúp chuột 

lên bất cứ mục nào bạn sẽ bật tính năng đó lên. Nhắp đúp chuột lên REC bạn sẽ bật tính năng 

ghi macro – hay còn gọi là thao tác tự động, TRK sẽ giúp bạn theo dõi ghi nhận mọi thay đổi mà 

bạn đã sửa lên văn bản gốc, EXT cho phép bạn có thể lựa chọn văn bản mà chỉ cần dùng phím 

mũi tên lên xuống sang phải sang trái và OVR sẽ bật tính năng ghi đè – tức là mỗi kí tự bạn gõ 

vào sẽ thay thế cho kí tự liền kề nó thay vì xuất hiện ngay bên cạnh. 

Tuỳ biến AutoText 

Chắc hẳn là bạn đã để ý thấy nhiều khi Word tự động thay thế và gợi ý giúp bạn những cụm từ 

kiểu như ―Best Wishes‖, ―Best regards‖…Đây chính là tính năng AutoText của Word. Bạn hoàn 

toàn có thể tự mình tuỳ biến danh sách các từ MS Word tự động thay thế giúp bạn. Bạn hãy vào 

Tools | AutoCorrect Options rồi chuyển sang mục AutoText. Trong cửa sổ AutoText bạn hãy gõ 

cụm từ mà bạn muốn Word tự động giúp bạn chèn vào mục Enter autotext entries here rồi nhắp 

chuột vào Add. Muốn gỡ bỏ bất cứ autotext nào bạn hãy chọn nó rồi nhắp chuột vào Delete. 

VII. Xử lý văn bản tốt hơn với AutoCorrect 

Microsoft ví chức năng AutoCorrect trong bộ phần mềm Office từ phiên bản 2000 trở về sau là 

―Người sửa văn bản qua vai bạn‖. Thông thường, tính năng tiện lợi này sẽ tự động chỉnh sửa từ 

ngữ, lỗi chính tả nhanh chóng tuy nhiên đôi lúc chúng thường chèn vào hay thay thế những từ 

mà bạn không muốn thay đổi như tên riêng chẳng hạn. 

Khi đó, tính năng ấy lại trở thành kẻ quấy nhiễu đầy phiền phức. Mặt khác, bạn cũng có thể 

dùng tính năng này để tự động bổ sung một đoạn văn bản vào tài liệu. 

Trước hết, hãy điểm sáng một cụm từ, một câu, một đoạn hay toàn bộ nội dung mà bạn thường 

xuyên cần đưa vào tập tin Word rồi chọn trình đơn Tools.AutoCorrect Options. Trong nhãn 

AutoCorrect, bạn sẽ nhìn thấy tất cả hoặc một phần nội dung được điểm sáng trước đó. Tiếp đến 

nhập vào các thao tác phím mà bạn sẽ dùng để kích hoạt khả năng tự động chèn thêm đoạn văn 

bản. Chẳng hạn như tạo từ khóa addr dùng cho địa chỉ hồi đáp của bạn, từ này sẽ xuất hiện ở bên 

trái đoạn văn bản đã được điểm sáng và bên dưới mục ‖Replace‖. Tiếp đến, đánh dấu tùy chọn 

Plain text hoặc Formatted text bên trên văn bản (nếu có sẵn) để xác lập định dạng cho nội dung 

văn bản được chèn vào tài liệu, sau đó nhấn Add. Tính năng AutoCorrect sẽ đặt từ khóa kích 

hoạt theo thứ tự bảng chữ cái giữa các mục hiện hành được liệt kê. Cuối cùng nhấn OK hoặc 

Close. 

Để chèn đoạn văn bản này vào tài liệu Word, bạn gõ vào từ khóa và kích hoạt tính năng 

AutoCorrect bằng cách nhấn Spacebar hoặc Enter, hoặc gõ thêm một dấu chấm (dấu này sẽ 

được thêm vào văn bản gốc). Lưu ý, nếu được nhắc nhở để chấp nhận các thay đổi trên định 

dạng chung (normal.dot) trước khi thoát khỏi Word thì bạn hãy chọn Yes, nếu không thì tất cả 

các thao tác vừa tạo trong AutoCorrect sẽ mất sạch. 

AutoCorrect cũng hoạt động trong Excel, Outlook và PowerPoint, mặc dù bạn không thể chọn 

trước văn bản trong các ứng dụng này và làm cho nó tự động xuất hiện trong mục ―Replace‖. 

Bạn có thể lưu văn bản mẫu dưới dạng văn bản thuần túy (plain text) hoặc văn bản được định 

dạng (formatted text), không có hạn chế nào về độ dài. Trong Word và Outlook, tính năng 

AutoCorrect còn cho phép bạn bổ sung hình ảnh (Hình 1). Để loại bỏ nội dung AutoCorrect, bạn 

chỉ cần mở lại hộp thoại AutoCorrect, điểm sáng từ khóa kích hoạt và nhấn Delete. 

VIII.TẬN DỤNG MACRO 

Nếu bạn đang tìm phương pháp chèn nhanh một đoạn văn bản để xem có bao nhiêu từ ở một 

kiểu font chữ cho trước sẽ lấp đầy một khoảng nhất định thì sử dụng macro rất tiện lợi. Sức 

mạnh đằng sau macro là ngôn ngữ lập trình VBA. Ngay cả trong trường hợp bạn dùng tính năng 

tạo marco tự động trong Word và Excel bằng cách nhấn Tools.Macro.Record New Macro thì chi 

tiết mã nguồn VBA cũng có thể được giấu kín. Bộ tạo macro tự động hoạt động như một bộ đệm 

(buffer), giấu kín mã Visual Basic ngay cả trong và sau quá trình tạo macro. Nếu không sử dụng 

tổ hợp phím <Alt>-<F11> hoặc chọn Tool.Macro.Visual Basic Editor thì bạn sẽ không bao giờ 

nhìn thấy được những đoạn mã này mặc dù thực tế nó luôn chạy ở chế độ nền. 



Ví dụ sau đây là một lệnh tiện lợi trong Word để tạo văn bản ―vô nghĩa‖. Trước hết hãy mở một 

tài liệu Word mới, gõ vào nội dung =rand(1) và nhấn Enter. Ngay lập tức, một đoạn văn bản 45 

từ lặp đi lặp lại nội dung ―The quick brown fox jumps over the lazy dog‖ sẽ xuất hiện. Chỉ cần 

thay đổi con số bên trong dấu ngoặc thì đoạn văn này sẽ lặp lại với số lần chính là con số bạn 

vừa nhập vào. 

IX. ĐỊNH DẠNG DỮ LIỆU TỐT HƠN TRONG EXCEL 

Một trong những việc mà người mới dùng Excel ngại nhất là định dạng dữ liệu, thường người 

dùng phải dò đến từng ô để đặt lại định dạng sai. Dưới đây là một vài mẹo nhỏ giúp bạn ―thuần 

phục‖ Excel, buộc nó phải định dạng dữ liệu đúng như ý bạn ngay từ lúc nhập liệu. 

• Để nhập một giá trị với định dạng tiền tệ (currency), hãy gõ một dấu đô la ($) phía trước giá trị 

cần nhập. 

• Để nhập một giá trị với định dạng phân số (fraction), hãy gõ một số 0 và một dấu cách phía 

trước phân số đó. Ví dụ: nhập ―0 1/2″ thay vì ―1/2″, Excel sẽ hiểu cần phải hiển thị giá trị theo 

định dạng phân số thay vì định dạng ngày tháng ―01-Feb‖. 

• Để nhập một giá trị với định dạng phần trăm (percentage), hãy gõ dấu % phía sau giá trị của 

bạn (ví dụ như 70%). 

• Để nhập một chuỗi số với định dạng văn bản (Text), hãy gõ một dấu ‗ ở phía trước chuỗi số 

đó. Mẹo này đặc biệt hữu ích vì Excel luôn ―thông minh thái quá‖ khi hiểu các chuỗi toàn chữ 

số là kiểu số và tự động định dạng chúng theo kiểu số. Những chuỗi số có số 0 ở đầu sẽ bị cắt 

hết những số 0 cần thiết. Nếu bạn nhập mã 08053, Excel sẽ định dạng theo kiểu số và chỉ hiển 

thị 8053. Để buộc Excel định dạng chuỗi đó theo kiểu text, bạn hãy gõ ‘08053. (Với những 

chuỗi số quá dài, Excel chuyển sang hiển thị dạng mũ còn khó coi hơn, ví dụ chuỗi 

123456789012 sẽ được chuyển thành 1,23457E+11). 

Biện pháp ―chữa cháy‖ 

Với những ô Excel đã định dạng theo kiểu số, dù bạn có định dạng lại theo kiểu text thì cách 

hiển thị của chúng vẫn không thay đổi. Để tránh phải gõ lại từ đầu, hãy làm như sau (lưu ý là 

cách làm này chỉ giúp bạn phá vỡ định dạng mũ ―ngứa mắt‖ chứ không cứu lại được những số 0 

ở phần đầu đã bị Excel cắt): 

- Chọn (bôi đen) ô cần chuyển sang định dạng kiểu text; chọn thực đơn Format/Cells, chuyển 

sang thẻ Number. 

- Chọn Text trong danh mục Category rồi nhấn nút OK. 

- Nhấn vào ô cần chuyển định dạng, nhấn F2 rồi nhấn ENTER.ÿ 

X. Tạo macro sửa lỗi thừa khoảng trắng trong Word 

Đầu tiên, bạn cần nắm qua quy tắc gõ dấu trong văn bản: các dấu chấm (.) hay dấu phẩy (,) phải 

luôn luôn nằm liền sau ký tự (không có khoảng trắng phía trước) và tiếp theo là một khoảng 

trắng rồi mới tới ký tự kế tiếp. Nếu bạn không muốn tìm và xóa các khoảng trắng thừa một cách 

thủ công, vừa tốn thời gian, đôi khi lại còn thiếu sót… bạn có thể tạo một macro để Word tự 

động thực hiện công việc giúp bạn. 

- Bước 1: Khởi động Word, vào menu Tools Macro Record New Macro. Lúc này hộp thoại 

Record Macro hiện ra, bạn gõ tudongkiemtra vào ô Macro name, các tuỳ chọn khác để mặc 

định. Sau đó nhấp 

- Bước 2: Trên màn hình Word xuất hiện thêm thanh công cụ Stop Recording 

phục vụ cho việc thu Macro. Con trỏ chuột của bạn sẽ kèm theo một cuộn băng. Bạn nhấp chuột 

vào menu Edit Replace. Trong hộp thoại Find and Replace bạn gõ các ký tự tìm kiếm vào ô Find 

what và ký tự thay thế vào ô Replace with. Ví dụ ở đây tôi gõ vào ô Find what là khoảng trắng 

và dấu chấm ( .), Replace with là dấu chấm (.). Sau đó nhấp Replace All để tìm và thay thế trong 

toàn bộ văn bản. Thực hiện tương tự cho các dấu còn lại như dấu khoảng trắng và dấu phẩy ( ,) 

sẽ thay bằng dấu phẩy (,), dấu khoảng trắng và dấu chấm than ( !) sẽ thay bằng dấu chấm than 

(!)… 

- Bước 3: Nhấp Stop Recording trên thanh công cụ. 



- Bước 4: Vào menu Tools Customize. Hộp thoại Customize xuất hiện, bạn nhấp tiếp vào 

Keyboard. Trong khung Categories bạn chọn Macros, ở khung Macros bên cạnh bạn chọn mục 

tudongkiemtra. Ở mục Press new shortcut key, bạn gõ phím nóng dễ nhớ vào ô này, ví dụ như 

Ctrl+Alt+B. Sau đó bạn nhấp Assign. 

Từ nay trở về sau mỗi khi cần xóa đi các khoảng trống thừa trong văn bản, bạn chỉ cần gõ phím 

nóng Ctrl+Alt+B là xong, thật nhanh chóng. 

XI. Trang trí văn bản giống trang báo 

1. Vào FormatColumns… 

2. Xuất hiện hộp thoại Columns: 

Presets: Lựa chọn loại cột, kiểu cột. 

Number of columns: Số cột sẽ chia. 

Width and spacing: Độ rộng cột và khoảng cách: 

Width: Độ rộng cột báo 

Spacing: Khoảng cách từ chữ đến đường viền cột 

RLine between: Xuất hiện đường kẻ dọc giữa các cột 

REqual column width: Mặc định độ rộng các cọt bằng nhau. Nếu để £ thì có thể điều chỉnh độ 

rộng các cột khác nhau tùy thích. 

Apply to: Áp dụng cho: 

Selected text: Áp dụng cho những đoạn văn bản đã lựa chọn (bôi đen) 

Whole document: Áp dụng cho toàn bộ file văn bản 

This point forward: Áp dụng cho từ dòng nội dung văn bản ở dưới điểm đặt con trỏ đến hết file. 

3. Chọn nút OK để hoàn thành việc chia văn bản thành cột báo. 

Trang trí chữ hoa đầu đoạn to đẹp giống trên báo chí. 

1. Lựa chọn (bôi đen) chữ đầu của đoạn văn bản 

2. Vào Format Drop cap… 

3. Xuất hiện hộp thoại Drop cap: 

Position: Vị trí đặt 

Dropped: Chữ đầu tiên của các dòng sau cùng đoạn văn bản hiển thị thẳng với mép ngoài (lề 

trái) của chữ hoa to. 

In Margin: Chữ đầu tiên của các dòng sau cùng đoạn văn bản hiển thị trong lề, thẳng với mép 

trong của chữ hoa to. 

Font: Chọn phông chữ. 

Line to drop: Chữ hoa to hiển ở mấy dòng. 

Distance from text: Đặt khoảng cách từ chữ hoa to xa với chữ tiếp theo của đoạn văn bản. 

4. Chọn nút OK để hoàn thành việc tạo chữ hoa to đầu đoạn văn bản 

XII. Chèn lời bình vào văn bản 

Cách 1: Chọn menu Insert –> Comment 

Cách 2: Trên thanh công cụ Reviewing, kích biểu tượng Insert 

Ở trạng thái Print Layout, Web Layout và Reading Layout, bạn sẽ quan sát thấy định dạng như 

sau: 

Sử dụng các nút trên thanh công cụ Reviewing để xác nhận hay hủy bỏ quá trình Track changes 

và để xóa các Comments (câu bình luận). 

1.Kích vào Previous để xem lại các thao tác diễn ra trước đó. 

2.Kích vào Next để xem các thao tác diễn ra sau đó cho đến thao tác sau cùng. 

3.Kích vào Accept Change để xác nhận quá trình soát lỗi. 

4.Kích vào Reject Change/Delete Comment để hủy bỏ quá trình soát lỗi và xóa phần bình luận. 

Định dạng Track changes trông sẽ khác nhau ở những chế độ nhìn khác nhau (Print Layout, 

Normal, Web layout, Reading layout, Outline). Khi đã sử dụng quen chế độ Track changes thì 

bạn sẽ tìm ra được dạng nào thì thích hợp nhất với bạn. 

Ở chế độ quan sát Print Layout, các dòng văn bản được xoá, các lời chú giải và cả định dạng văn 

bản nữa được hiển thị trong các ô ghi chú phía bên lề của văn bản. Cũng xuất hiện tương tự như 



chế độ Print Layout là chế độ quan sát Web Layout và dạng Reading Layout. 

Tuy nhiên, ở dạng Normal và Outline thì không có bất kì ô ghi chú nào cả. Dòng văn bản được 

xoá được thể hiện trong văn bản với một đường kẻ trên nó, và lời chú giải được thể hiện ở phía 

dưới cùng của văn bản trong phần Reviewing. 

Ngoài ra, ở tất cả các định dạng , dòng văn bản được chèn vào được thể hiện với những đường 

gạch chân và bôi màu riêng, và những đường kẻ đứng xuất hiện phía bên lề trái để chỉ rõ nơi sự 

sửa đổi vừa được thực hiện. 

Các chế độ hiển thị của ô ghi chú (Balloons) 

Bạn có thể thay đổi các chế độ hiển thị của Balloons bằng cách chọn menu Show nằm trên thanh 

công cụ Reviewing và thay đổi các chế độ. 

+ Always: Luôn luôn xuất hiện ô ghi chú trong quá trình thao tác văn bản 

+ Never: Không muốn xuất hiện ô ghi chú trong suốt quá trình thao tác văn bản 

+ Only for Comments/Formatting: Xuất hiện ô ghi chú đối với những lời chú giải và thao tác 

thay đổi trong văn bản, còn những dòng văn bản bị xóa đi sẽ hiển thị với đường kẻ gạch ngang 

qua. 

Kết luận 

Những phần bị xóa, phần chú giải hay những thay đổi định dạng sẽ xuất hiện trong các ô ghi chú 

(balloons) ở các chế độ quan sát: Print Layout, Web Layout và Reading Layout. Ngoài ra, bạn 

có nhiều sự lựa chọn về việc thể hiện sự chèn, xoá bỏ và thay đổi định dạng trong phần ―Tracks 

changes and Comment‖ với những kiểu chữ, font chữ, định dạng chữ khác nhau, không bắt buộc 

phải theo chế độ mặc định của Microsoft. Truy cập vào menu Show, chọn Options để có những 

sự lựa chọn riêng của bạn. Chúc thành công. 

XIII.Thay đổi độ giãn chữ. 

1. Lựa chọn (bôi đen) đoạn font chữ cần định dạng. 

2. Vào Format Font (Ctrl + D), xuất hiện hộp thoại Font 

3. Chọn thẻ Character spacing, hộp thoại Font có hình ảnh sau: 

Scale: Định dạng độ giãn chữ theo %. 

Spacing: Khoảng cách giữa các chữ 

By: Tăng: Giãn thưa chữ 

Giảm: Giãn chữ mau 

Position: Vị trí ở dòng 

By: Tăng: Vị trí chữ lên cao dần so với dòng 

Giảm: Vị trí xuống dần so với dòng 

Nút Default: Nếu muốn mặc định độ giãn chữ này cho các file sau. 

4. Chọn nút OK hoàn thành viện thay đổi độ giãn chữ. 

Trang trí chữ cho sinh động. 

1. Lựa chọn (bôi đen) đoạn font chữ cần định dạng. 

2. Vào Format Font (Ctrl + D), xuất hiện hộp thoại Font. 

3. Chọn thẻ Text Effects, hộp thoại Font có hình ảnh sau: 

Lựa chọn các hoạt hình chữ ở ô Animations. 

Nút Default: Nếu muốn mặc định độ giãn chữ này cho các file sau. 

4. OK 

Sau khi kích nút OK, đoạn font chữ đã chọn sẽ có kết quả nhấp nháy theo loại đã chọn ở ô 

AnimationsLưu ý: Với việc trang trí chữ cho sinh động này chỉ nhìn trên màn hình máy tính, khi 

in sẽ không xuất hiện những hình ảnh nhấp nháy. 

XIV. Thủ thuật thuyết trình bằng Powerpoint 

Microsoft Powerpoint tích hợp trong bộ Office là một phần mềm thông dụng nhất hiện nay dùng 

cho việc thuyết trình tại các cuộc hội thảo, giảng dạy… Đối với sinh viên sắp tốt nghiệp thì đa 
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số phải ―đụng‖ tới Powerpoint ít nhất một vài lần cho việc thuyết trình luận văn tốt nghiệp. 

Một số kinh nghiệm trong việc sử dụng Powerpoint sẽ giúp các bạn sinh viên soạn được một bài 

thuyết trình hấp dẫn, gây ấn tượng với hội đồng giám khảo, cùng một số mẹo hay để ứng phó 

với những tình huống bất ngờ trong khi trình chiếu Powerpoint. 

1. Chọn màu cho dương bản 

Việc chọn màu sắc dương bản rất quan trọng. Màu sắc lòe loẹt sẽ gây khó chịu cho người xem. 

Bạn nên chọn một màu đơn hơi tối, vừa không chói mắt lại vừa làm nổi bật màu chữ. Một gợi ý 

là chọn màu xanh dương đậm. Cách làm như sau: Mở chương trình Powerpoint, nhấn chuột phải 

vào dương bản và chọn Background. Hộp thoại Background mở ra, nhấn vào mũi tên sổ xuống, 

chọn Fill Effects. Hộp thoại Fill Effects mở ra, ở thẻ Gradient đánh dấu chọn One Color, rồi 

nhấn mũi tên sổ xuống bên cạnh, chọn More Color, hộp thoại Colors xuất hiện, bạn chọn tiếp 

thẻ Custom và chỉnh các thông số sau, Color model: RGB, Red: 0, Blue: 0, Green: 155, rồi nhấn 

OK để trở về hộp thoại Fill Effects. Tại hộp thoại này, bạn đánh dấu chọn vào mục From title ở 

dưới cùng, rồi chọn kiểu trung tâm sáng ngoại vi tối ở mục Variants bên cạnh, xong nhấn OK và 

Apply. Đó là màu cho dương bản thứ nhất. Với dương bản thứ hai, ba, bốn… bạn muốn cho 

màu giống dương bản một thì nhấn chuột phải vào dương bản một nằm ở cột dọc bên trái (thẻ 

Slides), chọn New Slide hay vào menu Insert > Duplicate Slide. 

2. Màu và kích cỡ cho Font chữ 

Chọn font chữ là một trong các font sau: Arial, Vni-Helve, Vni-Times, màu trắng, vàng, xanh lá 

cây, cam (nếu bạn chọn màu dương bản như trên), kích cỡ trong giới hạn từ 20-44 pt. Không 

nên chọn kích cỡ dưới 20 pt vì chữ sẽ nhỏ khi nhìn từ xa (trừ khi trình bày bảng số liệu thì có thể 

chọn cỡ thấp nhất là 20 pt). 

3. Tạo hiệu ứng cho dương bản, có nên hay không? 

Nhiều người cho rằng việc tạo hiệu ứng cho dương bản sẽ làm tăng tính hấp dẫn lôi cuốn người 

xem. Nhưng phải nói thật rằng cách này chỉ nên áp dụng cho các buổi trình chiếu quảng cáo sản 

phẩm hay tiếp thị. Còn với buổi trình luận văn tốt nghiệp thời gian thường chỉ có 20 phút, trong 

thời gian này bạn chỉ có thể sử dụng tối đa 30-40 dương bản, mỗi dương bản trình bày khoảng 

30-45 giây, vì vậy nếu bạn tạo nhiều hiệu ứng thì sẽ làm mất thời gian vô ích. Do vậy chỉ nên sử 

dụng 2 đến 3 hiệu ứng, bao gồm 1 hiệu ứng chuyển trang và 2 hiệu ứng cho chữ. 

Để tạo hiệu ứng cho chữ, nhấn chuột phải vào khung chứa chữ, chọn Custom Amination. Cửa sổ 

Add Effect xuất hiện ở bên phải, nhấp vào nút Add Effect để chọn hiệu ứng, ví dụ như Fly in 

(bay), Spin (quay tròn), Grow/Shrink (phóng to/thu nhỏ), Diamond (lấp lánh)… Kinh nghiệm 

cho thấy hiệu ứng Random Bars thường được sử dụng. Nếu bạn muốn áp dụng một kiểu hiệu 

ứng cho toàn bộ nội dung dương bản thì vào menu Slide Show->Amination Schemes. Cửa sổ 

Apply to selected Slides xuất hiện bên phải, bạn chỉ việc nhấn chọn hiệu ứng rồi vào Slide 

Show->View Show xem thử. 

Để tạo hiệu ứng chuyển trang, bạn vào Slide Show->Transition. Cửa sổ Slide Transition xuất 

hiện ở bên phải, bạn nhấn chọn hiệu ứng rồi vào Slide Show->View Show xem thử. Hiệu ứng 

Strips Right-Down thường được dùng nhất. 

4. Slide cảm ơn hội đồng giám khảo 

Đây là slide cuối cùng, không kém phần quan trọng. Bên cạnh lời cảm ơn, bạn có thể chèn hình 

ảnh các bông hoa, bạn có thể tải hình bông hoa miễn phí tại địa chỉ www.animationfactory.com 

(bạn vào trang web và tải những file zip tên loài hoa, ví dụ red_rose.zip). 

5. Một số phím tắt cần nhớ trong khi trình chiếu 

Đang trình bày ngon trớn thì một vị trong hội đồng giám khảo đột ngột bảo bạn cho xem lại một 

dương bản nào đó, hay kêu bạn chỉ cho họ những điểm quan trọng. Với tình huống này bạn có 

thể dùng phím tắt. 

• Ctrl – P: Lấy cây bút màu ra, dùng chuột vẽ một đường gạch đít hay khoanh tròn những điểm 

quan trọng. 

• Nhấn phím E: xóa đường gạch dưới hay khoanh tròn. 

• Nhấn phím Esc: Cất cây bút màu đi. 

• Ctrl – H: Che dấu chuột và nút nhấn (nằm ở góc dưới trái màn hình) 

http://www.animationfactory.com/


• Nhấn phím = (dấu bằng): hiển thị hay che dấu chuột. 

• Nhấn phím B/W: Chuyển màu đen/trắng khi đến giờ giải lao, nhấn lại phím này để trở về bình 

thường. 

• Page Up hay mũi tên lên: Đến dương bản trước. 

• Page Down hay Enter hay mũi tên xuống: Đến dương bản sau. 

• Nhấn số trang rồi nhấn Enter: Đến dương bản theo số trang. 

XV. Lưu các tập tin ở vị trí mặc định khác 

Có thể cho Microsoft Office biết nơi lưu trữ tập tin. Khi bạn mở hộp thoại Save As để lưu tập tin 

trong Word, Excel, PowrPoin, và Access. Chương trình chọn My Documents làm thư mục làm 

việc mặc định. Tuy có thể lưu tập tin vào thư mục bất kỳ, song bạn có lệ thích lưu thành quả của 

mình vào một thư mục cụ thể. 

Thay vì tự tay chọn thư mục khác từ thư mục My Documents mỗi lần lưu, bạn yêu cầu 

Microsoft Office lưu tập tin vào thư mục mặc định theo ý mình. Kiểm soát vị trí thư mục làm 

việc mặc định qua hộp thoại Options. Các bước thay đổi thư mục mặc định hơi khác tùy theo 

từng chương trình Office. 

Word là chương trình Office duy nhất cho phép duyệt ổ đĩa và thư mục trong hộp thoại Options 

để ấn định thư mục làm việc mặc định mới. Trong mọi chương trình khác, bạn phải gõ đầy đủ 

đường dẫn thư mục làm việc mặc định. 

* Ấn định thư mục trong Excel, PowerPoin, hay Access. 

1. Nhấp Tools. 

2. Nhấp Options. 

Hộp thoại Options mở ra. 

- Ghi chú Microsoft Outlook không có tùy chọn thay đổi thư mục làm việc mặc định. 

3. Trong Excel hay Access, nhấp tab General. 

Trong PowerPoint, nhấp tab Save. 

4. Bên trong trường hợp Default file location, chọn dòng văn bản My Documents rồi gỡ tên thư 

mục mong muốn. 

- Trong Access, nhấp bên trong trường hợp Default database folder sau đó gõ tên thư mục. 

5. Nhấp OK 

* Office gán thư mục mặc định mới. 

Ấn định thư mục mặc định trong Word 

1. Mở tại hộp thoại Options. 

2. Nhấp tab File Locations. 

3. Nhấp đúp kiểu tập tin Documents. 

Hộp thoại Modify Location mở ra. 

4. Gõ tên thư mục mới muốn lấy làm mặc định, hoặc nhấp thư mục sẽ dùng. 

5. Nhấp Ok. 

6. Nhấp OK. 

* Office gán thư mục mặc định mới. 

Tùy biến 

Có thể đổi tên thư mục My Documents bên trong cửa sổ My Computer. Trong Windows XP, thư 

mục My Documents sử dụng đường dẫn C:Documents and SettingsdefaultMy Documents. Nhấp 

tên thư mục hai lần, rồi gõ tên thư mục mới và nhấn ENTER. Tùy theo phương pháp cài đặt 

Office, Office setup có lẽ sử dụng vị trí thư mục khác nhau. 

XVI. Tạo các liên kết (Link) trong MS Word 

• Tạo các liên kết (Link) trong MS Word 

o Tạo liên kết đến 1 file khác hoặc 1 trang web 

o Tạo liên kết đến 1 file mới sẽ được tạo 

o Tạo liên kết đến địa chỉ Email 

o Tạo liên kết đến một vị trí bất kỳ ở cùng file 

• Tạo heading mới trong Office 2003 



• Đánh dấu (Bookmark) cho đoạn văn bản 

Tạo các liên kết (Link) trong MS Word 

1. Hãy lựa chọn (bôi đen) đoạn văn bản cần tạo liên kết. 

2. Vào Insert / Hyperlink… (Ctrl + K. Hoặc nháy chuột phải, chọn Hyperlink…) 

* Tạo liên kết đến 1 file khác hoặc 1 trang web. 

3. Tại hộp thoại Hyperlink, chọn Existing File or web page 

- Text to display: Nội dung hiển thị đoạn liên kết 

- Current Folder: Thư mục hiện thời 

- Browsed Pages: Các trang web đã trình duyệt gần thời gian hiện thời nhất 

- Recent files: Các file mới được mở gần thời gian hiện thời nhất. 

- Address: Tên địa chỉ và file chọn để link tới. 

- Nút ScreenTip…: Nhập nội dung khi di chuyển chuột vào liên kết sẽ hiển thị nội dung đó 

(Giống việc chèn chú thích): 

- Nút Bookmark: Đưa ra 1 địa chỉ nào đó đã đặt bookmark 

4. Chọn nút OK để hoàn thành việc đặt liên kết. 

* Tạo liên kết đến 1 file mới sẽ được tạo. 

3. Tại hộp thoại Hyperlink, chọn Creat New Document 

- Text to display: Nội dung hiển thị đoạn liên kết 

- Name of new document: Đặt tên cho file mới. 

- Nút Change… Thay đổi lại file liên kết đã có 

Bạn không nên chọn nút Change này bởi nội dung của file chọn sẽ bị mất sau khi nhấn nút OK 

và MS Word sẽ tự động tạo ra file trùng với tên đã chọn cùng với nội dung file trống. 

- Nút ScreenTip…: Nhập nội dung khi di chuyển chuột vào liên kết sẽ hiển thị nội dung đó 

(Giống việc chèn chú thích): 

- Nút Bookmark: Đưa ra 1 địa chỉ nào đó đã đặt bookmark 

4. Chọn nút OK để hoàn thành việc đặt liên kết. 

* Tạo liên kết đến địa chỉ Email. 

3. Tại hộp thoại Hyperlink, chọn E-mail Address 

- E-mail Address: Địa chỉ email đặt liên kết tới 

- Subject: Tên tiêu đề 

- Recently used e-mail address: Hiển thị những email đã được sử dụng gần thời điểm này nhất. 

Nội dung Subject và E-mail Address sẽ hiển thị khi bạn di chuyển chuột vào liên kết. 

4. Chọn nút OK để hoàn thành. 

* Tạo liên kết đến một vị trí bất kỳ ở cùng file. 

1. Trước hết bạn cần phải đánh dấu (đặt Bookmark hoặc Heading hoặc Style) cho dòng văn bản 

được link tới. 

2. Hãy lựa chọn (bôi đen) đoạn văn bản cần tạo liên kết. 

3. Vào Insert / Hyperlink… (Ctrl + K. Hoặc nháy chuột phải, chọn Hyperlink…) 

4. Tại hộp thoại Hyperlink, chọn Place in This Document 

Select a place in this document: Lựa chọn vùng tài liệu đã được đánh dấu: 

- Top of the Document: Đặt liên kết đến vị trí đầu tiên của file. 

- Headings: Đặt liên kết đến 1 heading nào đó đã có trong file 

- Bookmarks: Đặt liên kết đến 1 dòng văn bản đã được đánh dấu 

- Bạn có thể click vào dấu + để hiển thị chi tiết các mục trong Headings, Bookmarks,… 

Sau khi tạo xong bạn có thể dùng chuột click (hoặc Ctrl + chuột trái) vào đoạn văn bản vừa đặt 

để chuyển sang vùng liên kết mới. 

* Đánh dấu (Bookmark) cho đoạn văn bản 

1. Đặt trỏ chuột hoặc bôi đen đoạn dòng muốn đặt liên kết đến. 

2. Vào Insert / Bookmark… 

3. Xuất hiện hộp thoại Bookmark 

- Nhập tên đánh dấu tại ô Bookmark name (Tên này phải bắt đầu từ chữ cái và không có ký tự 



đặc biệt nào) 

4. Chọn nút Add để hoàn thành việc đặt Bookmark 

 


